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4. Weather Information Network Display (WIND)

4.1  XE "Weather Graphics function" Weather Graphics Function

The Weather Graphics function allows the user to display, animate, or sequence a wide variety of meteorological products, including:

· GOES Satellite imagery

· NEXRAD Radar

· Lightning graphics

· Analysis and Prognosis charts

· Weather Depiction

· Upper Air Analysis 

· Low/High Level Significant Weather Prognosis

· Forecast Upper Level Winds 

· Severe Weather Outlook

· Volcanic Ash and Hurricane charts

· Canadian Graphic Area Forecast (GFA) charts 

· Min/Max Temperatures

· Locally Produced Graphics

The user can enhance a display product by applying Geophysical, XE "Geophysical"  Boundaries, XE "Boundaries"  Sites, Aero, XE "Aero"  Transportation, Weather Warnings and Advisories, Pilot Reports, AIRMET, SIGMET, Temporary Flight Restrictions, and Storm Attribute XE "Transportation"  overlays. XE "Overlay:Background" 
4.1.1 WIND Window

The WIND window contains a menu bar, a toolbar, XE "Toolbar" \r "D2HBToolbar2"  the main work area, and a status bar.  Each of the functions available in the Weather Graphics window is accessed through the menu bar.  The menu bar initially consists of the File, Edit, Sequence, View, Options, and Help functions.  After a product has been loaded, additional functions are added and the menu bar expands to include File, Edit, Overlay, Control, Animation, XE "Animation:Menu" \r "D2HBAnimation2" 

 XE "Animation:Toolbar Section" \r "D2HBAnimation2"  Sequence, View, Options, Window, and Help functions.  This section discusses each Menu Bar function and the associated pull-down menu options within the Weather Graphics Window.
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Figure 4‑1  Weather Graphics Window

4.1.1.1 Toolbar

The Toolbar buttons provide quick access to many of the pull-down menu options on the Menu Bar.
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Figure 4‑2  Menu Bar and Toolbar

To Perform an Action From the Toolbar:

1. <Click> the Toolbar button for the action you want to perform.

NOTE:
This does not apply when the toolbar button is disabled
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Open Current Products
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Select Product Time
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View Oldest Product
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View Previous Product
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View Next Product
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View Latest Product
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Load Product Times for Animation
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Reverse Play
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Step Backward
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Stop Animation
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Step Forward
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Forward Play
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Set Animation Speed (1-12)
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Set Pause After Animation Loop (1-6)
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Quit Animation
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Load Sequence XE "Load Sequence" 

 XE "Sequence:Toolbar" \r "D2HBSequence3" 
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Reverse Play
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Stop Sequence
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Step Forward
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Set Sequence Rate
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Quit Sequence
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User State

[image: image29.png]



Help Topics XE "Help Topics" 
4.1.1.2  XE "Status Bar" 
Status Bar

The status bar is located at the bottom of the main WIND window.  It contains a number of panes that provide information about the current user session.
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Figure 4‑3  Status Bar

Table 4‑1  Status Bar Description

	Label 
	Component
	Purpose

	Status
	Pane
	Displays state of the application or displays prompts for menu items and toolbar buttons.

	Terminal ID
	Pane
	Displays the ID of the briefing terminal.

	Lat/Long Coordinates
	Pane
	Displays the Lat/Long coordinates corresponding to the current mouse position on the map.  


4.2 File

The File menu provides an interface for the primary file operations.  The file menu initially consists of the Current Product, XE "Current Product" \r "D2HBCurrent_Prod5"  Print Setup, and Exit operations.
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Figure 4‑4  File Menu

After a product has been loaded, additional operations are added and the File menu expands to include Current Product, Close, Save, Save As, Print, Print Preview, Print Setup, and Exit operations.
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Figure 4‑5  File Menu (with a product selected)

To Display the File Menu:

1. <Click> File on the menu bar.

4.2.1 Current Product

The Current Product menu option, available from the File menu, displays the Current Products dialog box.  The Current Products dialog box provides the capability to select specific weather products for display from a list of available meteorological categories called Classes.  Classes of meteorological data include: satellite imagery, radar imagery, NWS products, and various other meteorological products.

The Current Products dialog box contains two list boxes that provide the Class and Clipboard.  The first list box contains the various Classes of available meteorological categories.  The second list box contains the Clipboards, which further define the list of specific products available for display.

[image: image34.png]Classes Clpboards.
E_FORECASTS [A_HAW_SURFACE
C60ES [AZSFC_ATIONAL
D_HAZARDS C WX DEPICTION
E_UPPER_AIR D_RADAR_SUM
F_PROPERTIES E_LIGHTNING
G_WINDS_ALOFT | TR_EsNEXRAD
L K WNDSALOFT KIF_EATE
M_PIFEF K NEXRAD-LTG
MizPs K Wik, DEPSLTG:
NEXRAD SITES N FREEZING LVL

isplay Cancel Propetes. Delete





Figure 4‑6  Current Products Dialog Box

Table 4‑2  Current Products Dialog Box Description
	Label
	Component
	Purpose

	Classes
	List Box
	Displays a list of product categories available from the Weather Graphics database.

	Clipboards
	List Box
	Displays a list of products, within a selected Class, available from the Weather Graphics database.

	Display
	Button
	Downloads and displays the selected product (Class and Clipboard) within a new Weather Graphics window.

	Cancel
	Button
	Cancels the Current Products dialog box without applying or accepting any changes.

	Properties
	Button
	Displays the Properties dialog box which provides the ability to setup or change the Download, Flight Plan and Stored Overlay Selection properties of a selected product.  The Properties dialog box is also available from the Edit menu or by clicking the right mouse button on the active product.

	Delete
	Button
	Removes the selected product from the local disk.


To Display a Current Product:

1. <Click> File on the menu bar.

2. <Select> the Current Product menu option to display the Current Products dialog box.

3. <Select> the desired Class from the list box.

4. <Select> the desired Clipboard from the list box.

5. <Click> the Display button to display the selected product.  The menu bar and File menu change to include additional options.  You may also double  <Click> on the desired Clipboard item to display the product.


OR

6. <Click> the Cancel button to terminate this function without opening a product.

NOTE:
Clicking the Properties button will open the Properties dialog box.  See the Edit Menu section for additional information on setup or changing  properties.

To Delete a Current Product:

1. <Click> File on the menu bar.

2. <Select> the Current Product menu option to display the Current Products dialog box.

3. <Select> the desired Class from the list box.

4. <Select> the desired Clipboard from the list box

5. <Click> the Delete button.

OR

6. <Click> the Cancel button to terminate this function without deleting a product.

NOTE:
If a product is open and it is deleted from the Current Products window, it can be regenerated by selecting "Request Latest Product XE "Request Latest Product" " from the Control menu.  If product is not open and it is deleted from the Current Products window, the user can open Download Client, <Click> the "Connected to…" button, ensure that "Quick Sync" is checked, and <Click> OK.

4.2.2 Close

The Close menu option, available from the File menu, provides the capability to close the active Weather Graphics Window.

To Close a Product Window:

1. <Click> File on the menu bar.

2. <Select> the Close option.

OR

3. <Click> the Close button in the upper right corner of the window.

NOTE:
This procedure assumes that a product window has been opened.

4.2.3 Save

Not currently supported as indicated by the grayed-out state of the option.

4.2.4 Save As

Not currently supported as indicated by the grayed-out state of the option.

4.2.5 Print

The Print menu option, available from the File menu, displays the Print dialog box.  The Print Setup dialog box provides the capability to select the printer, print range, and number of copies for printing.
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Figure 4‑7  Print Dialog Box

Table 4‑3  Print Dialog Box Description

	Label
	Component
	Purpose

	Printer
	Group Label
	Allows the user to select a printer.

	Name
	Drop-down List Box
	Displays a list of installed printers.

	Status
	Text Label
	Displays the status of the printer.

	Type
	Text Label
	Displays the type of printer.

	Where
	Text Label
	Displays the location of the printer.

	Comment
	Text Label
	Displays any additional comments.

	Properties
	Button
	Displays the properties dialog box for the selected printer.

	Print range
	Group Label
	Allows the user to specify range of pages to print.

	All
	Radio Button
	Selects all pages to be printed.

	Pages
	Radio Button
	Selects a specified range of pages to be printed.

	from
	Text Box
	Specifies a page number to start printing from.

	to
	Text Box
	Specifies a page number to stop printing.

	Selection
	Radio Button
	Selects only the information selected to be printed.

	Copies
	Group Label
	Allows the user to select number of copies to print and gives the option to collate multiple copies.

	Number of copies
	Increment Box
	Specifies the number of copies to be printed.

	Collate
	Check Box
	Selects the collate option.  Collate prints and sorts the specified number of copies in order.

	OK
	Button
	Applies any changes and sends to printer.

	Cancel
	Button
	Closes the dialog box without accepting any changes.


To Print a Currently Displayed Product:

1. <Click> File on the menu bar.

2. <Select> the Print menu option to display the Print dialog box.

3. <Select> the desired printer from the Name drop-down list box.

4. <Select> the print range from the Print range group

5. <Select> the number of copies from the Copies group.

6. <Click> the OK button to complete the function and close the display.

OR

7. <Click> the Cancel button to terminate this function without accepting any of the changes made and close the display.

NOTE:
Paper, Graphics, and PostScript attributes for the printer can be set using the Properties button.

4.2.6 Print Preview

The Print Preview menu option displays the product in the currently active window, as it will appear when printed.  When the print preview option is selected, the product is displayed in a print preview layout window with a menu bar consisting of Print, Next Page, Prev Page, Two Page, Zoom XE "Zoom"  In, Zoom Out, and Close functions.
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Figure 4‑8  Print Preview Layout Window

Table 4‑4  Print Preview Layout Window Description

	Label
	Component
	Purpose

	Print
	Button
	Closes the print preview layout window and displays the Print dialog box.

	Next Page
	Button
	Displays the next page if available.

	Prev Page
	Button
	Displays the previous page if available.

	Two Page/One Page 
	Button
	Toggles between displaying two consecutive pages side by side, or one page at a time.

	Zoom In
	Button
	Enlarges the view of the displayed product.

	Zoom Out
	Button
	Reduces the view of the displayed product.

	Close
	Button
	Closes the Print Preview Layout window.


To Preview a Currently Displayed Product:

1. <Click> File on the menu bar.

2. <Select> the Print Preview menu option to display the product in a Print Preview layout window.

3. Use the Page and Zoom XE "Zoom"  options to view the product as desired.

4. <Click> the Print button on the menu bar to close the Print Preview layout window and display the print dialog box.

5. <Click> the Close button on the menu bar to close the Print Preview layout window.

4.2.7 Print Setup

The Print Setup menu option, available from the File menu, displays the Print Setup dialog box.  The Print Setup dialog box provides the capability to select a printer and to choose the size, source, and orientation of the paper used for printing.
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Figure 4‑9  Print Setup Dialog Box

Table 4‑5  Print Setup Dialog Box Description

	Label
	Component
	Purpose

	Printer
	Group Label
	Allows the user to select printer.

	Name
	Drop-down List Box
	Displays a list of installed printers.

	Status
	Text Label
	Displays the status of the printer.

	Type
	Text Label
	Displays the type of printer.

	Where
	Text Label
	Displays the location of the printer.

	Comment
	Text Label
	Displays any additional comments.

	Properties
	Button
	Displays the properties dialog box for the selected printer.

	Paper
	Group Label
	Allows the user to select the size and source of the paper used for printing.

	Size
	Drop-down List Box
	Displays a list of standard paper sizes.

	Source
	Drop-down List Box
	Displays a list of paper sources.

	Orientation
	Group Label
	Allows the user to select the direction the product will be printed on the paper.

	Portrait
	Radio Button
	Sets the paper orientation vertically.

	Landscape
	Radio Button
	Sets the paper orientation horizontally.

	Network
	Button
	Allows selection of other printers if any are available.

	OK
	Button
	Accepts and applies any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.


To Set Print Options:

1. <Click> File on the menu bar.

2. <Select> the Print Setup menu option to display the Print Setup dialog box.

3. <Select> the desired printer from the Name drop-down list box.

4. <Select> the desired paper size from the Size drop-down list box.

5. <Select> the desired paper source from the Source drop-down list box.

6. <Select> the desired paper orientation from the Orientation radio buttons

7. <Click> the OK button to complete the function and close the display

OR

8. <Click> the Cancel button to terminate this function without accepting any of the changes made and close the display.

NOTE:
Paper, Graphics, and PostScript attributes for the printer can be set using the Properties button.

4.2.8 Exit

The Exit menu option, available from the File menu, provides the capability to shut down and exit the Weather Information Network Display (WIND).

To Exit WIND:

1. <Click> File on the menu bar.

2. <Select> the Exit menu option.  The Weather Information Network Display (WIND) windows are closed, and the application is shut down.

4.3 Edit

The Edit menu provides an interface for product properties XE "Product Properties"  operations.  The Edit menu consists of the Properties option, which is only available after a product has been loaded or a flight profile has been generated from WINGS.

The Properties menu option displays a Properties dialog box.  From the Properties  dialog box, the user can modify the properties of a graphic product or of  a cross-sectional flight plan, which ever is active.
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Figure 4‑10  Edit Menu

To Display the Edit Menu:

1. <Click> Edit on the menu bar.

4.3.1 Product Properties

There are separate dialog boxes for the properties associated with a product and the properties associated with a cross-sectional flight plan.  When a current product is active, the Properties menu option, available from the Edit menu, displays the Product Properties dialog box.  The Product Properties dialog box may also be displayed by using the right mouse button while the cursor is positioned over the graphic image.

The Properties dialog box for current products provides the capability to setup or change the Download, XE "Download" \r "D2HBDownload13"  Flight Plan, Stored Overlay XE "Overlay:Stored"  Selections, AIRMET, SIGMET, Weather, Pilot Report, Temporary Flight Restrictions, and Storm Attributes XE "Storm Attributes"  using the respective tabbed pages.  These properties are unique for each Class/Clipboard product.

4.3.1.1 Download

The Download tabbed page provides the option to setup or change the hours and minutes before a specific product on the local disk (i.e. user's workstation) is considered old.  This is the time that will be used by the product scrubber to determine when a product is to be deleted from the local disk.  The words "OLD IMAGE" will be printed across the top of any currently viewed product as a visual indicator that the product is old.

The Download tabbed page also provides the option to designate the number of product versions to be saved to the local disk.  This number will also be used to determine the maximum number of product times available for animation.
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Figure 4‑11  Download Tabbed Page

Table 4‑6  Download Tabbed Page Description

	Label
	Component
	Purpose

	Hours and Minutes
	Text Boxes
	Specifies the number of hours and minutes until a product on the local drive is considered old. 

	Number of Product Versions
	Text Box
	Specifies the number of product versions to be kept on the local disk.  This number also determines the maximum number of product times available for animation.

	OK
	Button
	Accepts any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.

	Apply
	Button
	Grayed out until a change has been made in a text box for this tabbed page.  Accepts any changes without closing the dialog box.


To Modify the Download Properties:

1. <Click> Edit on the menu bar.

2. <Select> the Properties menu option to display the Properties dialog box.

3. Enter a number inside the Hours textbox to change the existing entry.

4. Enter a number inside the Minutes textbox to change the existing entry.

5. Enter a number inside the Number of Product Versions text box to change the number of product versions saved on the local disk.

6. <Click> the OK button to complete the function and close the dialog box.

OR

7. <Click> the Cancel button to terminate this function without accepting any of the changes made and close the dialog box.

NOTE:
This procedure assumes that a product has been loaded.

4.3.1.2  XE "Flight Plan:Display" Flight Plan

The Flight Plan tabbed page provides the options to setup or change the color, thickness of lines, and style and type of font used for flight plan overlays. XE "Overlay:Flight Plan"   It also provides the options to designate the maximum number, to enable or disable, and to set the display properties of the flight plan overlays.

Flight Plan overlays are a graphical representation of a route of flight, overlaid on any open graphic products which support overlays.  To display a Flight Plan overlay, <Click> the "Route Overlay" button (located on the Flight Plan dialog box) or the "Briefing XE "Briefing"  Overlay" button (located on the Weather and Aeronautical Briefing window).
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Figure 4‑12  Flight Plan Tabbed Page

Table 4‑7  Flight Plan Tabbed Page Description

	Label
	Component
	Purpose

	Flight Plan Color
	Color Button
	Displays the Colo XE "Color dialog box" \r "D2HBColor_Dialog15" r dialog box. 

	Line Width
	Text Box
	Specifies the line width.

	Max Number of Flight Plan Overlays
	Text Box
	Specifies the maximum number of flight plan overlays allowed per product.

	Font
	Button
	Displays the Font dialog box. 

	
	Drop-down List Box
	Allows the user to choose the type of marks used to display flight plans.  The choices are graphical Points or alphanumeric Text identifiers.  If Text is selected, Fix/Radial/Distance points will be displayed as ‘F’ and Lat/Long points will be displayed as ‘L’.

	Enable Flight Plan Overlays
	Check Box
	Selects the flight plan overlay function to be activated.

	Display Waypoints
	Check Box
	Toggles the display of waypoints in the flight plan overlay.  Waypoints draw as an ‘X’ or a point depending upon the selection in the Drop-down List Box.

	OK
	Button
	Accepts any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.

	Apply
	Button
	Accepts any changes without closing the dialog box.


To Modify the Flight Plan XE "Flight Plan:Display"  Properties:

1. <Click> Edit on the menu bar.

2. <Select> the Properties menu option to display the Properties dialog box.

3. <Click> the Flight Plan tab to display the Flight Plan tabbed page.

4. <Click> the Flight Plan Color button to display the Color dialog box to modify the existing color

5. Enter the desired line width (1-5) in the Line Width text box.

6. Enter the maximum number of flight plan overlays XE "Overlay:Flight Plan"  (0-10) in the Max Number of Flight Plan Overlays text box.

7. <Click> the Font button to display the Font dialog box to modify the existing font settings.

8. <Click> the Drop-down List Box to select Text or Points display.

9. <Click> the Enable Flight Plan Overlays check box to activate the overlay function
10. <Click> the Display Waypoints check box to enable or disable the display of waypoints in the flight plan.

11. <Click> the OK button to complete the function and close the display.

OR

12. <Click> the Cancel button to terminate this function without accepting any of the changes made and close the display.

NOTE:
This procedure assumes that a product has been loaded.

Color Dialog Box

The Color dialog box is opened via many functions throughout WIND.  The Color dialog box is used to select colors on the active display.  Additionally, when the Define Custom Colors button is pressed, the color dialog box expands to allow the creation of new colors.
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Figure 4‑13  Color Dialog Box
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Figure 4‑14  Color Dialog Box (with Define Custom Colors selected)

Table 4‑8  Color Dialog Box Description

	Label
	Component
	Purpose

	Basic colors
	Color Boxes
	Allows the user to select a basic color.  Box becomes highlighted when selected.

	Custom colors
	Color Boxes
	Allows the user to select a color created from the custom colors area.  Box becomes highlighted when selected.

	Define Custom Colors
	Button
	Displays the custom colors area.

	
	Workspace
	Allows the user to change color values without changing the luminescence.

	
	Slider Bar
	Allows the user to change the luminescence of colors without changing the hue or saturation.

	Color/ Solid
	Display Box
	Displays the newly created color.

	Hue
	Text Box
	Specifies the hue of the chosen color.

	Sat
	Text Box
	Specifies the saturation of the chosen color.

	Lum
	Text Box
	Specifies the luminescence of the chosen color.

	Red
	Text Box
	Specifies the amount of red contained in the chosen color.

	Green
	Text Box
	Specifies the amount of green contained in the chosen color.

	Blue
	Text Box
	Specifies the amount of blue contained in the chosen color.

	Add to Custom Colors
	Button
	Allows the user to store a created color as custom colors.

	OK
	Button
	Accepts any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.


To Change Colors:

1. <Click> the Color button to open the Color dialog box.

2. <Select> a basic or custom color.  The color is highlighted.

3. <Click> the OK button to complete the function and close the display.  The new color is shown on the color button.

OR

4. <Click> the Cancel button to terminate this function without accepting any of the changes made and close the display.

To Create Custom Colors:

1. <Click> the Color button to open the Color dialog box

2. <Select> the Custom colors box where the new color will be stored.  The box is highlighted.

3. <Click> the Define Custom Colors button to open custom colors area.

4. <Click> anywhere in the workspace or use the slider bar to create the desired color.

5. <Click> the Add to Custom Colors button.  The new color is added to the custom colors box.

6. <Click> the OK button to complete the function and close the display.  The new color is shown on the color button.

OR

7. <Click> the Cancel button to terminate this function without changing the color of the color button.  The newly created color is stored as a custom color.

Font Dialog Box XE "Font Dialog Box" 
The Font dialog box is opened via many functions throughout WIND.  The Font dialog box is used to select the type, style and size font used on flight plan XE "Flight Plan:Display"  overlays. XE "Overlay:Flight Plan" 
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Figure 4‑15  Font Dialog Box

Table 4‑9  Font Dialog Box Description

	Label
	Component
	Purpose

	Font
	Scroll List
	Allows the user to select from a list of available fonts.  Selected item is highlighted and displayed above the scroll list.

	Font style
	Scroll List
	Allows the user to select from a list of available font styles.  Selected item is highlighted and displayed above the scroll list.

	Size
	Scroll List
	Allows the user to select from a list of available font sizes.  Selected item is highlighted and displayed above the scroll list.  

	Sample
	Display Box
	Displays an example of the selected font, style, size, and script.

	Script
	Drop-down List Box
	Allows the user to select from a drop-down list of available scripts.  Selected item is highlighted and displayed in the list box.

	OK
	Button
	Accepts any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.


To Change Fonts:

1. <Click> the Font button to open the Font dialog box.

2. <Select> a font, style, size, or script.  The choices are highlighted and an example is displayed in the Sample display box.

3. <Click> the OK button to complete the function and close the display.

OR

4. <Click> the Cancel button to terminate this function without accepting any of the changes made and close the display.

4.3.1.3  XE "Overlay:Stored" Stored Overlay Selections

The Stored Overlay Selections tabbed page provides the option to select a category for storing, or selecting previously stored, background overlays.  There are four categories for stored background overlays: Instrument Flight Rules (IFR), Visual Flight Rules XE "Visual Flight Rules"  (VFR), None, and Saved.

Overlays that are created and stored as IFR or VFR overlays are available for all current product types.  An overlay that is created and stored as Saved can only be applied to the specific product for which it was created.

Opening a current product using any of these three categories will overlay the product with the previously stored background overlay.  However, applying any of the stored overlays will not affect the currently loaded product.  The product must be redisplayed for the changes to take effect or applied from the Current Products window before the product is initially displayed.
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Figure 4‑16  Stored Overlay Selections Dialog Box 

Table 4‑10  Stored Overlay XE "Overlay:Stored"  Selections Tabbed Page Description

	Label
	Component
	Purpose

	Stored Background Overlay Selection
	Drop-down List
	Allows the user to choose the category used for stored background  overlays.  If IFR or VFR is selected, then the background overlays selected from the ‘Options->Saved IFR/VFR Overlays’ main menu will automatically be placed on the product when the product is displayed. SAVED restores any background overlays that were placed on the product when the product was closed.  NONE allows the product to be initially displayed with no overlays, regardless of what was previously placed on the product.

	OK
	Button
	Accepts any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.

	Apply
	Button
	Grayed out until a change has been made.  Accepts any changes without closing the dialog box.


To Modify the Stored Overlay Selection:

1. <Click> Edit on the menu bar.

2. <Select> the Properties menu option to display the Properties dialog box.

3. <Click> the Stored Overlay Selections tab to display the Stored Overlay Selections tabbed page

4. <Select> the desired stored background category from the Stored Background Overlay Selection drop-down list.

5. <Click> the OK button to complete the function and close the display.

OR

6. <Click> the Cancel button to terminate this function without accepting any of the changes made and close the display.

NOTE:
This procedure assumes that a product has been loaded.

To Display a Current Product XE "Current Product"  with Stored Overlays:

1. <Click> File on the menu bar.

2. <Select> the Current Product menu option to display the Current Products dialog box.

3. <Select> the desired Class from the list box.

4. <Select> the desired Clipboard from the list box.

5. <Click> the Properties button to display the Properties dialog box.

6. <Click> the Stored Overlay Selections tab to display the Stored Overlay Selections tabbed page.

7. <Select> the desired stored background category from the Stored Background Overlay Selection drop-down list.

8. <Click> the OK button to complete the function and close the display.

9. <Click> the Display button to display the selected product.  The product is displayed with the selected background overlay. XE "Overlay:Background" 
NOTE:
This procedure assumes that a background overlay has previously been stored in the category selected from the Stored Background Overlay Selection drop-down list.

4.3.1.4  XE "AIRMETs" AIRMETs

The AIRMETs product property page allows the user to set up the drawing options for the dynamic plot AIRMET overlay.  Any plot types selected to be drawn on the product will be updated automatically when new plot data is received on the Weather Graphics Server. XE "Weather Graphics Server" \r "D2HBWeather_Grap22"   If two or more AIRMETs have the same polygon, they are drawn as a dashed line alternating between the colors of the different AIRMETs.  
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Figure 4‑17  AIRMETs Dialog Box

Table 4‑11  AIRMET Tabbed Page Description

	Label
	Component
	Purpose

	AIRMET Types
	Group Label
	Color buttons and check boxes for selection of AIRMET products.

	AIRMET Types Color Boxes
	Color Button
	Displays the Color dialog boxes for the selected AIRMET types.

	AIRMET Types Check Boxes
	Check Box
	Selects the plot types to be drawn when the OK or Apply button is selected.

	Place on Toolbar
	Check Box
	Places the AIRMET toolbar at the top of the product.

	Line Width
	Text Box
	Specifies the line width.

	Labels
	Group Label
	Label display options: Off or On,  Font, and Opaque.

	Off/On
	Radio Button
	Toggles labels Off/On for each plot type that is selected to be drawn on the product.  For decluttering purposes, Labels are placed along the top and bottom of the product with a dotted line drawn from the label text to the estimated center of the drawn plot.  The number of labels that will fit depends on font settings.  If there are more labels than will fit across the top and bottom, then the additional labels will be centered to the drawn plot type.

	Font
	Button
	Displays the Font dialog box. 

	Opaque
	Check Box
	Draws the label text with an opaque background.

	Tooltips
	Group Label
	Tool Tip options: either label or full report.

	Show Label/Show Full Report
	Radio Button
	Toggles the tooltip from the label to the full report when the mouse is positioned over a drawn plot type.  Tooltips are also known as ‘Fly Over Help’.  The tooltip will display plot information for the closest drawn plots to the mouse pointer.  If plots are of equal distance to the mouse, then information for all plots of equal distance will be displayed with a ‘NEXT REPORT’ separating each report/label.  In addition to the tooltip being displayed, each plot being referenced in the tooltip will be drawn bolded.

	OK
	Button
	Accepts any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.

	Apply
	Button
	Accepts any changes without closing the dialog box.


4.3.1.5  XE "SIGMETs" \r "D2HBSIGMETs23" SIGMETs

The SIGMETs product property page allows the user to set up the drawing options for the dynamic plot SIGMET overlay. XE "Overlay:Dynamic Plot"   Any plot types selected to be drawn on the product will be updated automatically when new plot data is received on the Weather Graphics Server.  If two or more SIGMETs have the same polygon, they are drawn as a dashed line alternating between the colors of the different SIGMETs.  
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Figure 4‑18  SIGMETs Dialog Box

Table 4‑12  SIGMET Tabbed Page Description

	Label
	Component
	Purpose

	SIGMET Types
	Group Label
	Color buttons and check boxes for selection of SIGMET products.

	SIGMET Types Color Boxes
	Color Button
	Displays the Color dialog boxes for the selected SIGMET types.

	SIGMET Types Check Boxes
	Check Box
	Selects the plot types to be drawn when the OK or Apply button is selected.

	Place on Toolbar
	Check Box
	Places the SIGMET toolbar at the top of the product.

	Line Width
	Text Box
	Specifies the line width.

	Labels
	Group Label
	Label display options: Off or On,  Font, and Opaque.

	Off/On (Labels)
	Radio Button
	Toggles labels Off/On for each plot type that is selected to be drawn on the product.  For decluttering purposes, Labels are placed along the top and bottom of the product with a dotted line drawn from the label text to the estimated center of the drawn plot.  The number of labels that will fit depends on font settings.  If there are more labels than will fit across the top and bottom, then the additional labels will be centered to the drawn plot type.

	Font
	Button
	Displays the Font dialog box. 

	Opaque
	Check Box
	Draws the label text with an opaque background.

	Tooltips
	Group Label
	Tool Tip options: either label or full report.

	Show Label/Show Full Report (Tooltips)
	Radio Button
	Toggles the tooltip from the label to the full report when the mouse is positioned over a drawn plot type.  Tooltips are also known as ‘Fly Over Help’.  The tooltip will display plot information for the closest drawn plots to the mouse pointer.  If plots are of equal distance to the mouse, then information for all plots of equal distance will be displayed with a ‘NEXT REPORT’ separating each report/label.  In addition to the tooltip being displayed, each plot being referenced in the tooltip will be drawn bolded.

	OK
	Button
	Accepts any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.

	Apply
	Button
	Accepts any changes without closing the dialog box.


4.3.1.6 Weather

The Weather product property page allows the user to set up the drawing options for the dynamic plot weather overlay. XE "Overlay:Dynamic Plot"   Any plot types selected to be drawn on the product will be updated automatically when new plot data is received on the Weather Graphics Server. XE "Weather Graphics Server" \r "D2HBWeather_Grap25"   
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Figure 4‑19  Weather Dialog Box

Table 4‑13  Weather Tabbed Page Description

	Label
	Component
	Purpose

	Weather Types
	Group Label
	Color buttons and check boxes for selection of Weather products.

	Color Boxes
	Color Button
	Displays the Color dialog boxes for the selected Weather types.

	Check Boxes
	Check Box
	Selects the plot types to be drawn when the OK or Apply button is selected.

	Place on Toolbar
	Check Box
	Places the Weather toolbar at the top of the product.

	Line Width
	Text Box
	Specifies the line width.

	Labels
	Group Label
	Label display options: Off or On,  Font, and Opaque.

	Off/On
	Radio Button
	Toggles labels Off/On for each plot type that is selected to be drawn on the product.  For decluttering purposes, Labels are placed along the top and bottom of the product with a dotted line drawn from the label text to the estimated center of the drawn plot.  The number of labels that will fit depends on font settings.  If there are more labels than will fit across the top and bottom, then the additional labels will be centered to the drawn plot type.

	Font
	Button
	Displays the Font dialog box. 

	Opaque 
	Check Box
	Draws the label text with an opaque background.

	Tooltips
	Group Label
	Tool Tip options: either label or full report.

	Show Label/Show Full Report
	Radio Button
	Toggles the tooltip from the label to the full report when the mouse is positioned over a drawn plot type.  Tooltips are also known as ‘Fly Over Help’.  The tooltip will display plot information for the closest drawn plots to the mouse pointer.  If plots are of equal distance to the mouse, then information for all plots of equal distance will be displayed with a ‘NEXT REPORT’ separating each report/label.  In addition to the tooltip being displayed,  each plot being referenced in the tooltip will be drawn bolded

	OK
	Button
	Accepts any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.

	Apply
	Button
	Accepts any changes without closing the dialog box.


4.3.1.7 Pilot Report

The Pilot Report product property page allows the user to set up the drawing options for the dynamic plot pilot report overlay. XE "Overlay:Dynamic Plot"   Any plot types selected to be drawn on the product will be updated automatically when new plot data is received on the Weather Graphics Server.  
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Figure 4‑20  Pilot Report Dialog Box 

Table 4‑14 Pilot Report Tabbed Page Description

	Label 
	Component
	Purpose

	Pilot Report Types
	Group Label
	Color buttons and check boxes for selection of Pilot Report types.

	Pilot Report Types Color Boxes 
	Color Button
	Displays the Color dialog box for the selected Pilot Report types.  

	Pilot Report Types Check Boxes 
	Check Box
	Selects the plot types to be drawn when the OK or Apply button is selected.

	Time Before Pilot Reports Expire
	Group Label
	Allows selection of time before a Pilot Report expires

	Hours and Minutes
	Spin Boxes
	Selects hours and minutes before a Pilot Report expires.  The maximum is 2 hours.

	Place on Toolbar 
	Check Box
	Places the Pilot Report toolbar at the top of the product.

	Graphical Depiction
	Group Label
	Radion buttons and check boxes for selection of display dots, display symbols, and opaque drawing.

	Display Symbols/Display Dots
	Radio Button
	Toggles the drawing mode for all pilot reports.  When display symbols is selected, a symbol for the type/severity of the phenomenon is plotted.  If the type or severity cannot be determined a small dot is drawn on the screen.  When display dots is selected, all pilot reports are drawn as small dots.  If a symbol is available, it is drawn when the item is tooltipped.

	Draw Altitude with Symbols 
	Check Box
	Draws the altitude next to the pilot report symbol.  This option has no affect if “Display Dots” is selected.  Altitudes will not be plotted with any pilot report that is drawn as a dot.

	Draw Opaque 
	Check Box
	Draws the labels and the altitude with an opaque background.  In this mode, when an item is tooltipped, it will be drawn in front of other pilot reports.

	Altitude Filtering
	Group Label
	Check boxes and spin boxes that allow selection of altitudes to be displayed.

	Show Altitudes Below 
	Check Box
	Filters the Pilot Reports being displayed.  Only Pilot Reports which occur below the specified altitude will be displayed.  The Pilot Report will be drawn if any part of the phenomenon occurs below the specified altitude.  Pilot Reports without a valid numeric altitude will also be displayed.

	Show Altitudes Below 
	Spin Box
	The altitude in 100’s of feet to use for the Below Altitude filter.  Any change to this altitude will also change the Above Altitude filter. 

	Show Altitudes Above 
	Check Box
	Filters the Pilot Reports being displayed.  Only Pilot Reports which occur above the specified altitude will be displayed.  The Pilot Report will be drawn if any part of the phenomenon occurs above the specified altitude.  Pilot Reports without a valid numeric altitude will also be displayed.

	Show Altitudes Above 
	Spin Box
	The altitude in 100’s of feet to use for the Above Altitude filter.  Any change to this altitude will also change the Below Altitude filter.

	Show Altitudes Between 
	Check Box
	Filters the Pilot Reports being displayed.  Only Pilot Reports which occur between the specified altitudes will be displayed.  The Pilot Report will be drawn if any part of the phenomenon occurs between then specified altitudes.  Pilot Reports without a valid numeric altitude will also be displayed.

	Show Altitudes Between 
	Spin Boxes
	Specifies the altitude range in 100’s of feet for the Between Altitude filter.

	OK
	Button
	Accepts any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.

	Apply
	Button
	Accepts any changes without closing the dialog box.


Table 4‑15  Pilot Report Symbols

	Label
	Description 
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	Light Turbulence 
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	Moderate Turbulence 
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	Severe Turbulence 
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	Clear Sky Cover 
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	Few Sky Cover 
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	Scattered Sky Cover 
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	Broken Sky Cover 
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	Overcast Sky Cover 
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	Trace Clear Icing 
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	Light Clear Icing 
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	Moderate Clear Icing 
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	Severe Clear Icing 
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	Trace Rime Icing 
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	Light Rime Icing 
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	Moderate Rime Icing 
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	Severe Rime Icing 
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	Trace Mixed Icing 
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	Light Mixed Icing 

	[image: image77.png]



	Moderate Mixed Icing 
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	Severe Mixed Icing 


4.3.1.8 Temporary Flight Restrictions

The Temporary Flight Restrictions property page allows the user to set up the drawing options for the dynamic plot temporary flight restriction overlay. XE "Overlay:Dynamic Plot"  Any plot types selected to be drawn on the product will be updated automatically when new plot data is received on the Weather Graphics Server.   XE "Weather Graphics Server" 
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Figure 4‑21  Temporary Flight Restrictions Dialog Box
Table 4‑16  Temporary Flight Restrictions  XE "Temporary Flight Restriction"  Dialog Box Description
	Label
	Component
	Purpose

	TFR Types
	Group Label
	Color buttons and check boxes for selection of Temporary Flight Restriction types.

	TFR Types Color Boxes
	Color Button
	Displays the Color dialog box for that Temporary Flight Restriction type.

	TFR Types Check Boxes
	Check Box
	Selects the plot types to be drawn when the OK or Apply button is selected.

	Place on Toolbar
	Check Box
	Places the Temporary Flight Restriction toolbar at the top of the product.

	Line Width
	Text Box
	Specifies the line width for Presidential and Non Presidential Temporary Flight Restriction types.

	State Line Width
	Text Box
	Specifies the line width for Presidential State and Non Presidential State Temporary Flight Restriction types.

	OK
	Button
	Accepts any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.

	Apply
	Button
	Accepts any changes without closing the dialog box.


4.3.1.9  XE "Storm Attributes" \r "D2HBStorm_Attrib29" Storm Attributes

The Storm Attributes product property page allows the user to set up the drawing options for the storm attribute overlay. XE "Overlay:Storm"   The user can select the radar station they would like to see the storm attributes for.  The overlay will be updated automatically.

[image: image80.png]ITES/MLB_BASE_TILT1 Properties
Dowload | FightPln | Stored Oveey Sletons |
Wester | FiotRepon | Tenporay Fight Restoions
Stom Atibute Colrs DiplyStoms or

= Radatie 16w
[ SevereHai

[ Mesa

& ™

™ Enable Storm Attibute Overlay
7 Display Storm Atiute Table below Image.

Storm Labels

T DrawStomlsbel

7 Draw Opague

Aimet | signet |
Stom Attrbutes

L]

=





Figure 4‑22  Storm Attribute Dialog Box

Table 4‑17  Storm Attributes Tabbed Page Description

	Label 
	Component
	Purpose

	Storm Attribute Colors
	Group Label
	Displays the colors that represent each Storm Attribute.

	Hail
	Color Button
	Displays the color currently being used to display the presence of hail in a storm.  This color is used in both the table at the bottom of the image, and in the lower half of the storm symbol.

	Severe Hail
	Color Button
	Displays the color currently being used to display the presence of severe hail in a storm.  This color is used in both the table at the bottom of the image, and in the lower half of the storm symbol.  

	MESO
	Color Button
	Displays the color currently being used to display the presence of MESO in a storm.  This color is used in both the table at the bottom of the image, and around the outer circle of the storm symbol.

	TVS
	Color Button
	Displays the color currently being used to display the presence of TVS in a storm.  This color is used in both the table at the bottom of the image, and in the upper half of the storm symbol.

	Enable Storm Attribute Overlay
	Check Box
	Enables the storm attribute overlay on the current product.

	Display Storm Attribute Table below Image
	Check Box
	Enables the storm attribute table to be displayed beneath the current image.  The table allows the user to see information about each storm, as well as toggle each storm on and off.

	Storm Labels
	Group Label
	Selections allow display of Storm Labels, Opaque labels, and font.

	Draw Storm Labels
	Check Box
	Displays the storm ID next to each storm on the product.

	Draw Opaque
	Check Box
	If this box is checked, the labels will be drawn with a white box behind them.  When this box is not checked, the labels will be drawn with a transparent background.

	Font
	Button
	Displays the Font Dialog Box XE "Font Dialog Box"  which allows the user to select the type, style, and size of font used for the storm attribute overlay.

	Display Storms For Radar Site
	List Box
	Allows the user to select the radar site for which the storm attribute data will be displayed.  The list will only contain radar sites that are located on the current product.  The user may double click an entry to make the change in station take effect immediately.

	OK
	Button
	Accepts any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.

	Apply
	Button
	Accepts any changes without closing the dialog box.


Table 4‑18  Storm Attribute Symbols Description

	Symbol
	Description
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	Basic storm symbol.  This symbol indicates the presence of a storm that has no MESO, TVS, Hail, or Severe Hail characteristics.
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	Hail symbol.  This symbol indicates the storm has a POH of 30% or more.  The color of the bottom of the circle can be changed in the storm attribute property page.
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	Severe Hail symbol.  This symbol indicates the storm has a POSH of 30% or more.  The color of the bottom of the circle can be changed in the storm attribute property page.
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	MESO symbol.  This symbol indicates the presence of MESO in the storm.  The color used around the outer portion of the circle can be changed in the storm attribute property page.
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	TVS symbol.  This symbol indicates the presence of TVS in the storm.  The color of the top of the circle can be changed in the storm attribute property page.


The storm attribute symbols can be combined to indicate multiple phenomena within the storm.  However, Severe Hail and Hail cannot be displayed within the symbol, so the more severe of the two will be displayed in the symbol.  If the storm has a forecasted path, a line will be displayed with the symbol with three plus signs.  These mark the forecasted position of the storm at 15, 30, and 60 minutes.  The example below indicates some of the possible combinations of the symbols.
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Figure 4‑23  Storm Attribute Overlay XE "Overlay:Storm"  Example

4.3.2  XE "Cross Sectional" \r "D2HBCross_Sectio32" Cross Sectional Flight Plan

(This function is currently disabled)

The Cross Sectional Flight Plan displays information for each leg along the route.  The information displayed consists of the aircraft ID, estimated time of arrival (ETA), distance between points, flight level, temperature, wind speed, wind direction, and location identifiers.  Wind speed and wind direction are indicated by meteorological wind barbs as well as in textural format.  Temperature, wind speed, and wind direction apply to the midpoint of each leg.
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Figure 4‑24  Cross-Sectional Flight Plan Window 

4.3.3 Cross Sectional Flight Plan Properties

(This function is currently disabled)

There are separate dialog boxes for the properties associated with a product and the properties associated with a cross sectional flight plan.  When a cross sectional flight plan is active, the Properties menu option, available from the Edit menu, displays the Cross Sectional Properties dialog box.

The Properties dialog box for cross sectional flight plans provides the capability to change the filter points, pixel width, and font size selections.  This dialog box consists of the Filter Points Closer Than, Minimum Pixel Width, and Font Size slider bar selection tools.
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Figure 4‑25  Cross Sectional Properties Dialog Box 

Table 4‑19  Cross Sectional Properties Dialog Box Description

	Label
	Component
	Purpose

	Filter Points Closer Than
	Slider Bar
	To eliminate points on the cross-sectional flight plan which fall within the specified proximity of the previous point..

	
	Text Box
	Proximity factor on which the points of the cross-sectional flight plan are filtered.

	Minimum Pixel Width
	Slider Bar
	Allows the user to change the width (distance between) the pixels in the cross-sectional flight plan window.

	
	Text Box
	Displays the distance between pixels in the cross-sectional flight plan window.

	Font Size
	Slider Bar
	Allows the user to change the size of the font used on the labels in a cross sectional flight plan window.

	
	Text Box
	Displays the size of the font used on the labels in a cross-sectional flight plan window.

	OK
	Button
	Accepts any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.


To Modify a Cross Sectional Flight Plan Window:

1. <Click> Edit on the menu bar.

2. <Select> the Properties menu option to display the Properties dialog box

3. <Click> on the desired slider bar slider to change the filter points, pixel width, or font size selections

4. <Drag> the slider bar, while keeping the left mouse button depressed, until the number in the corresponding text box reaches the desired value.

5. <Click> the OK button to complete the function and close the display.

OR

6. <Click> the Cancel button to terminate this function without accepting any of the changes made and close the display.

NOTE:
This procedure assumes that a cross sectional flight plan window has been displayed from WINGS.
4.4  XE "Overlay:Background" Overlay

The Overlay menu provides an interface for adding various overlays to a displayed product.  The Overlay menu consists of the Background Overlays and Clear Flight Plan XE "Clear Flight Plan" 

 XE "Flight Plan:Display"  options.  The Overlay Menu is only available after a product has been loaded.  Additionally, the Clear Flight Plan option is only available after a Flight Plan has been displayed from WINGS.
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Figure 4‑26  Overlay Menu 

To Display the Overlay Menu:

1. <Click> Overlay on the menu bar.

NOTE:
This procedure assumes that a product has been loaded.

4.4.1 Background Overlays

The Background Overlays menu option, available from the Overlay menu, displays the Background Overlays dialog box.  The Background Overlays dialog box provides the capability to setup or change graphic overlays.

The dialog box consists of the Geophysical, XE "Geophysical" \r "D2HBGeophysical36"  Boundaries, XE "Boundaries"  Sites, Aero XE "Aero"  (Aeronautical), and Transportation XE "Transportation"  tabbed pages.
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Figure 4‑27  Background Overlays Dialog Box 

4.4.1.1 Geophysical

The Geophysical tabbed page of the Background Overlays XE "Overlay:Background"  dialog box provides the options to mark the boundaries between physical properties such as latitude and longitude or water and land masses.  It also provides the capability to mark the position of rivers.
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Figure 4‑28  Geophysical Overlay 
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Figure 4‑29  Geophysical Tabbed Page 

Table 4‑20  Geophysical Tabbed Page Description

	Label
	Component
	Purpose

	Color Buttons
	Button
	Displays the selected or default color for the corresponding overlay and opens the Color dialog box when selected.

	Latitude/ Longitude
	Check Box
	Selects the Latitude/Longitude overlay to be displayed.

	Land/ Sea
	Check Box
	Selects the Land/Sea overlay to be displayed.

	Rivers
	Check Box
	Selects the Rivers overlay to be displayed.


To Add Geophysical Background Overlays:

1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Geophysical tab to display the Geophysical tabbed page.

4. <Click> the corresponding check box or boxes to select one or more Geophysical overlays.  The display is updated with the selected overlay(s).

5. <Click> the corresponding Color button(s) to open the Color dialog box and change the displayed color of an overlay.

6. <Click> the Close button in the upper right corner to close the Background Overlays dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

4.4.1.2  XE "Boundaries" \r "D2HBBoundaries38" Boundaries

The Boundaries tabbed page of the Background Overlays XE "Overlay:Background"  dialog box provides the options to mark the outside boundary lines for Air Route Traffic Control Center (ARTCC), sector (High, Low, and Super High), geopolitical (countries and states), county boundaries, and Alaskan Subsections.
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Figure 4‑30  Boundaries Overlay 
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Figure 4‑31  Boundaries Tabbed Page 

Table 4‑21  Boundaries Tabbed Page Description

	Label
	Component
	Purpose

	Color Buttons
	Button
	Displays the selected or default color for the corresponding overlay and opens the Color dialog box when selected.

	ARTCC Boundaries
	Check Box
	Selects the ARTCC Boundaries overlay to be displayed.

	High Sector Boundaries
	Check Box
	Selects the High Sector Boundaries overlay to be displayed.

	Low Sector Boundaries
	Check Box
	Selects the Low Sector Boundaries overlay to be displayed.

	Super High Sector Boundaries
	Check Box
	Selects the Super High Sector Boundaries overlay to be displayed.

	Alaskan Subsections
	Check Box
	Selects the Alaskan Subsections to be displayed.

	Counties
	Check Box
	Selects the County overlay to be displayed.

	Geopolitical
	Check Box
	Selects the Geopolitical overlay to be displayed.

	Select
	Buttons
	Displays the dialog box for making changes to the respective overlay settings.


To Add Boundary Background Overlays:

1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Boundaries tab to display the Boundaries tabbed page.

4. <Click> the corresponding check box or boxes to select one or more Boundary overlays.  The display is updated with the selected overlay(s).

5. <Click> the corresponding Color button(s) to open the Color dialog box XE "Color dialog box"  and change the displayed color of an overlay. XE "Overlay:Background" 
6. <Click> the Close button in the upper right corner to close the Background Overlays dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

Select ARTCC Boundaries

The Select ARTCC Boundaries dialog box is available from the Boundaries tabbed page of the Background Overlays dialog box.  This provides options to filter the boundaries to be displayed with the ARTCC Boundaries background overlay.  The Select button to the right of the ARTCC Boundaries label displays the Select ARTCC Boundaries dialog box.
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Figure 4‑32  Select ARTCC Boundaries Dialog Box

 Table 4‑22  Select ARTCC Boundaries Dialog Box Description

	Label
	Component
	Purpose

	Display All ARTCC Boundaries 
	Check Box
	Selects all ARTCC Boundaries for display on the active product.

	Enter ARTCCs To Display
	Text Box
	Allows the user to enter IDs for specific ARTCC Boundaries.

	Enter ARTCCs To Display
	Scroll List
	Stores entered ARTCC Boundaries IDs in alphabetical order for easy reference.

	High
	Check Box
	Enables/Disables the display of High ARTCC Boundaries

	CTA High
	Check Box
	Enables/Disables the display of CTA High ARTCC Boundaries

	Low
	Check Box
	Enables/Disables the display of Low ARTCC Boundaries

	FIR Only
	Check Box
	Enables/Disables the display of FIR Only ARTCC Boundaries

	Boundary
	Check Box
	Enables/Disables the display of Boundary ARTCC Boundaries

	UTA
	Check Box
	Enables/Disables the display of UTA ARTCC Boundaries

	Add
	Button
	Adds IDs entered in the text box to the scroll list.

	Delete
	Button
	Removes highlighted IDs from the scroll list.

	Font
	Button
	Displays the Font dialog box to allow changes in style or size of label fonts

	
	Drop-down List Box
	Allows the user to choose the type of marks used to indicate sites.  The selections are Off, Text, or Diamonds.

	Line Thickness
	Slider Control
	Selects the drawing line thickness for the ARTCC Boundaries

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Display Only Specific ARTCC Boundaries Background Overlay: XE "Overlay:Background" 
1.
<Click> Overlay on the menu bar.

2.
<Select> the Background Overlays menu option to display the Background Overlays dialog box.

3.
<Click> the Boundaries tab to display the Boundaries tabbed page.

4.
<Click> the ARTCC Boundaries check box.  The display is updated with the ARTCC Boundaries overlay.

5.
<Click> the Select button to the right of the ARTCC Boundaries label to display the Select ARTCC Boundaries dialog box.

6.
Uncheck the Display All ARTCC Boundaries checkbox

7.
Enter the specific IDs for each ARTCC Boundary needed in the Enter ARTCCs To Display text box. 

8.
<Click> the Add button for each ID entered.  The ARTCCs are added to the scroll list and the boundaries are displayed on the active product.

9.
<Click> the OK button to close the Select ARTCC Boundaries dialog box when all selections are complete.

To Display Only Specific Types of ARTCC Boundaries Background Overlay: XE "Overlay:Background" 
1.  
<Click> Overlay on the menu bar.

2.  
<Select> the Background Overlays menu option to display the Background Overlays dialog box.

3.  
<Click> the Boundaries tab to display the Boundaries tabbed page.

4.  
<Click> the ARTCC Boundaries check box.  The display is updated with the ARTCC Boundaries overlay.

5.  
<Click> the Select button to the right of the ARTCC Boundaries label to display the Select ARTCC Boundaries dialog box.

6.
Check or Uncheck High, CTA High, Low, FIR Only, Boundary, or UTA checkboxes in order to specify which type(s) of ARTCC Boundaries to display.

7.  
<Click> the OK button to close the Select ARTCC Boundaries dialog box when all selections are complete.

NOTE:  These procedures assume that a product has been loaded.

Select High Sectors

The Select High Sectors dialog box is available from the Boundaries tabbed page of the Background Overlays dialog box.  This provides options to filter sectors to be displayed with the High Sectors background overlay.  The Select button to the right of the High Sectors label displays the Select High Sectors dialog box.
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Figure 4‑33 Select High Sectors Dialog Box

Table 4‑23 Select High Sectors Dialog Box Description

	Label
	Component
	Purpose

	Display All High Sectors 
	Check Box
	Selects all High Sectors for display on the active product.

	Enter High Sectors To Display
	Text Box
	Allows the user to enter IDs for specific High Sectors.

	Enter High Sectors To Display
	Scroll List
	Stores entered High Sectors IDs in alphabetical order for easy reference.

	Add
	Button
	Adds IDs entered in the text box to the scroll list.

	Delete
	Button
	Removes highlighted IDs from the scroll list.

	Line Thickness
	Slider Control
	Selects the drawing line thickness for the High Sectors

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Display Only Specific High Sectors Background Overlay: XE "Overlay:Background" 
1.
<Click> Overlay on the menu bar.

2.
<Select> the Background Overlays menu option to display the Background Overlays dialog box.

3.
<Click> the Boundaries tab to display the Boundaries tabbed page.

4.
<Click> the High Sector Boundaries check box.  The display is updated with the High Sector Boundaries overlay.

5.
<Click> the Select button to the right of the High Sector Boundaries label to display the Select High Sectors dialog box.

6.
Uncheck the Display All High Sectors checkbox

7.
Enter the specific IDs for each High Sector needed in the Enter High Sectors To Display text box. 

8.
<Click> the Add button for each ID entered.  The sectors are added to the scroll list and displayed on the active product.

9.
<Click> the OK button to close the Select High Sectors dialog box when all selections are complete.

NOTE:  This procedure assumes that a product has been loaded.

Select Low Sectors

The Select Low Sectors dialog box is available from the Boundaries tabbed page of the Background Overlays dialog box.  This provides options to filter sectors to be displayed with the Low Sectors background overlay.  The Select button to the right of the Low Sectors label displays the Select Low Sectors dialog box. 

[image: image99.png]Lowssats |

7 Display All Low Sectors

Eter Low Sectars To Display
|7
Add Delte

Line Thickness:

—





Figure 4‑34 Select Low Sectors Dialog Box

Table 4‑24 Select Low Sectors Dialog Box Description

	Label
	Component
	Purpose

	Display All Low Sectors 
	Check Box
	Selects all Low Sectors for display on the active product.

	Enter Low Sectors To Display
	Text Box
	Allows the user to enter IDs for specific Low Sectors.

	Enter Low Sectors To Display
	Scroll List
	Stores entered Low Sectors IDs in alphabetical order for easy reference.

	Add
	Button
	Adds IDs entered in the text box to the scroll list.

	Delete
	Button
	Removes highlighted IDs from the scroll list.

	Line Thickness
	Slider Control
	Selects the drawing line thickness for the Low Sectors

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Display Only Specific Low Sectors Background Overlay: XE "Overlay:Background" 
1.
<Click> Overlay on the menu bar.

2.
<Select> the Background Overlays menu option to display the Background Overlays dialog box.

3.
<Click> the Boundaries tab to display the Boundaries tabbed page.

4.
<Click> the Low Sector Boundaries check box.  The display is updated with the Low Sector Boundaries overlay.

5.
<Click> the Select button to the right of the Low Sector Boundaries label to display the Select Low Sectors dialog box.

6.
Uncheck the Display All Low Sectors checkbox

7.
Enter the specific IDs for each Low Sector needed in the Enter Low Sectors To Display text box. 

8.
<Click> the Add button for each ID entered.  The sectors are added to the scroll list and displayed on the active product.

9.
<Click> the OK button to close the Select Low Sectors dialog box when all selections are complete.

NOTE:  This procedure assumes that a product has been loaded.

Select Super High Sectors

The Select Super High Sectors dialog box is available from the Boundaries tabbed page of the Background Overlays XE "Overlay:Background"  dialog box.  This provides options to filter sectors to be displayed with the Super High Sectors background overlay.  The Select button to the right of the Super High Sectors label displays the Select Super High Sectors dialog box. 
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Figure 4‑35 Select Super High Sectors Dialog Box

Table 4‑25 Select Super High Sectors Dialog Box Description

	Label
	Component
	Purpose

	Display All Super High Sectors 
	Check Box
	Selects all Super High Sectors for display on the active product.

	Enter Super High Sectors To Display
	Text Box
	Allows the user to enter IDs for specific Super High Sectors.

	Enter Super High Sectors To Display
	Scroll List
	Stores entered Super High Sectors IDs in alphabetical order for easy reference.

	Add
	Button
	Adds IDs entered in the text box to the scroll list.

	Delete
	Button
	Removes highlighted IDs from the scroll list.

	Line Thickness
	Slider Control
	Selects the drawing line thickness for the Super High Sectors

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Display Only Specific Super High Sectors Background Overlay: XE "Overlay:Background" 
1.  
<Click> Overlay on the menu bar.

2.  
<Select> the Background Overlays menu option to display the Background Overlays dialog box.

3.  
<Click> the Boundaries tab to display the Boundaries tabbed page.

4.  
<Click> the Super High Sector Boundaries check box.  The display is updated with the Super High Sector Boundaries overlay.

5.  
<Click> the Select button to the right of the Super High Sector Boundaries label to display the Select Super High Sectors dialog box.

6.
Uncheck the Display All Super High Sectors checkbox

7.  
Enter the specific IDs for each Super High Sector needed in the Enter Super High Sectors To Display text box. 

8.  
<Click> the Add button for each ID entered.  The sectors are added to the scroll list and displayed on the active product.

9.  
<Click> the OK button to close the Select Super High Sectors dialog box when all selections are complete.

NOTE:  This procedure assumes that a product has been loaded.

Select Alaskan Subsections

The Select Alaskan Subsections dialog box is available from the Boundaries tabbed page of the Background Overlays dialog box.  This provides options to filter the subsections to be displayed with the Alaskan Subsections background overlay.  The Select button to the right of the Alaskan Subsections label displays the Select Alaskan Subsections dialog box.
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Figure 4‑36  Select Alaskan Subsections Dialog Box

Table 4‑26  Select Alaskan Subsections Dialog Box Description

	Label
	Component
	Purpose

	Display All Alaskan Subsections 
	Check Box
	Selects all Alaskan Subsections for display on the active product.

	Enter Subsections To Display
	Text Box
	Allows the user to enter IDs for specific Alaskan Subsections.

	Enter Subsections To Display
	Scroll List
	Stores entered Alaskan Subsections IDs in alphabetical order for easy reference.

	Juneau
	Check Box
	Enables/Disables the display of Juneau Alaskan Subsections

	Anchorage
	Check Box
	Enables/Disables the display of Anchorage Alaskan Subsections

	Fairbanks
	Check Box
	Enables/Disables the display of Fairbanks Alaskan Subsections

	Add
	Button
	Adds IDs entered in the text box to the scroll list.

	Delete
	Button
	Removes highlighted IDs from the scroll list.

	Font
	Button
	Displays the Font dialog box to allow changes in style or size of label fonts

	
	Drop-down List Box
	Allows the user to choose the type of marks used to indicate sites.  The selections are Off, Text, or Stars.

	Line Thickness
	Slider Control
	Selects the drawing line thickness for the Alaskan Subsections

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Display Only Specific Alaskan Subsections Background Overlay: XE "Overlay:Background" 
1.
<Click> Overlay on the menu bar.

2.
<Select> the Background Overlays menu option to display the Background Overlays dialog box.

3.
<Click> the Boundaries XE "Boundaries"  tab to display the Boundaries tabbed page.

4.
<Click> the Alaskan Subsections check box.  The display is updated with the Alaskan Subsections overlay.

5.
<Click> the Select button to the right of the Alaskan Subsections label to display the Select Alaskan Subsections dialog box.

6.
Uncheck the Display All Alaskan Subsections checkbox

7.
Enter the specific IDs for each Alaskan Subsections needed in the Enter Subsections To Display text box. 

8.
<Click> the Add button for each ID entered.  The Alaskan Subsections are added to the scroll list and the boundaries are displayed on the active product.

9.
<Click> the OK button to close the Select Alaskan Subsections dialog box when all selections are complete.

To Display Only Specific Types of Alaskan Subsections Background Overlay:

1.
<Click> Overlay on the menu bar.

2.
<Select> the Background Overlays menu option to display the Background Overlays dialog box.

3.
<Click> the Boundaries tab to display the Boundaries tabbed page.

4.
<Click> the Alaskan Subsections check box.  The display is updated with the Alaska Subsections overlay.

5.
<Click> the Select button to the right of the Alaskan Subsections label to display the Select Alaskan Subsections dialog box.

6.
Check or Uncheck the Juneau, Anchorage, or Fairbanks checkboxes in order to specify which Alaskan Subsections to display.

7.
<Click> the OK button to close the Select Alaskan Subsections dialog box when all selections are complete.

NOTE:  These procedures assume that a product has been loaded.

Select Counties

The Select Counties dialog box is available from the Boundaries tabbed page of the Background Overlays dialog box.  This provides options to filter the counties to be displayed with the Counties background overlay.  The Select button to the right of the Counties label displays the Select Counties dialog box.
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Figure 4‑37  Select Counties Dialog Box

Table 4‑27  Select Counties Dialog Box Description

	Label
	Component
	Purpose

	Display All Counties 
	Check Box
	Selects all counties for display on the active product.

	Enter County Name or FIPS Code
	Text Box
	Allows the user to enter county names or FIPS codes for the display of specific counties.

	Enter County Name or FIPS Code
	Scroll List
	Stores entered county names and/or FIPS codes in alphabetical order for easy reference.

	States
	Scroll List
	Allows the user to select specific states in which to display the counties overlay.

	Add
	Button
	Adds IDs entered in the text box to the scroll list.

	Delete
	Button
	Removes highlighted IDs from the scroll list.

	Font
	Button
	Displays the Font dialog box to allow changes in style or size of label fonts

	Display County Names
	Check Box
	Allows the user to enable or disable the drawing of the county names.

	Line Thickness
	Slider Control
	Selects the drawing line thickness for the Counties overlay

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Display Only Specific Counties Background Overlay: XE "Overlay:Background" 
1.
<Click> Overlay on the menu bar.

2.
<Select> the Background Overlays menu option to display the Background Overlays dialog box.

3.
<Click> the Boundaries XE "Boundaries"  tab to display the Boundaries tabbed page.

4.
<Click> the Counties check box.  The display is updated with the Counties overlay.

5.
<Click> the Select button to the right of the Counties label to display the Select Counties dialog box.

6.
Uncheck the Display All Counties checkbox.

7.
Enter the specific county names or FIPS codes for each county needed in the Enter County Name or FIPS Code text box. 

8.
<Click> the Add button for each county name or FIPS code entered.  The county names and/or FIPS codes are added to the scroll list and the counties are displayed on the active product.

9.
<Click> the OK button to close the Select Counties dialog box when all selections are complete.

To Display Only Counties in Specific States Background Overlay:

1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Boundaries tab to display the Boundaries tabbed page.

4. <Click> the Counties check box.  The display is updated with the Counties.

5. <Click> the Select button to the right of the Counties label to display the Select Counties dialog box.

6. Uncheck the Display All Counties checkbox.  Note that the States scroll list is now enabled.

7. Select or Unselect specific states in the States scroll list.  Counties are displayed in the selected states on the active product.

8. <Click> the OK button to close the Select Counties dialog box when all selections are complete.

NOTE:  These procedures assume that a product has been loaded.

4.4.1.3 Sites

The Sites tabbed page of the Background Overlays dialog box provides the options to mark airports, navigational aids (NAVAIDs), radar site locations, TAF reporting stations, surface observation stations, upper air sounding stations, Synoptic Stations, and GPS/RAIM. XE "GPS/RAIM" \r "D2HBGPS_RAIM52"   Each of these options can be customized to include specific sites.

When a site is marked, holding the cursor over the mark displays any additional information in a fly-over text box.  If a product becomes too cluttered with overlay marks, zooming in on an area will help separate the individual marks.
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Figure 4‑38  Site Overlay 
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Figure 4‑39  Sites Tabbed Page 

Table 4‑28  Site Tabbed Page Description

	Label
	Component
	Purpose

	Color Buttons
	Button
	Displays the selected or default color for the corresponding overlay.  Opens the Color dialog box when selected.

	Airports XE "Airports" \r "D2HBAirports52" 
	Check Box
	Selects Airports overlay to be displayed.

	Navigational Aids (NAVAIDS)
	Check Box
	Selects the Navigational Aids (NAVAIDS) overlay to be displayed.

	Radar Site Locations
	Check Box
	Selects the Radar Site Locations overlay to be displayed.

	TAF Reporting Stations
	Check Box
	Selects the TAF Reporting Stations overlay to be displayed.

	Surface Observation Stations
	Check Box
	Selects the Surface Observation Stations overlay to be displayed.

	Upper Air Sounding Stations
	Check Box
	Selects the Upper Air Sounding Stations overlay to be displayed.

	Synoptic Stations
	Check Box
	Selects the Synoptic Stations overlay to be displayed.

	GPS/RAIM
	Check Box
	Selects Global Positioning System/Receives Autonomous Integrity Monitoring (GPS/RAIM) overlay to be displayed.  This allows users to visually decipher GPS satellite outages for any time range up to 54 hours in advance.   The GPS/RAIM schedule process may be launched from a product by using the right mouse button and selecting the desired surface observation station ID once the GPS/RAIM is overlaid.

	Select
	Buttons
	Displays the dialog box for making changes to the respective overlay settings.


To Add Site Background Overlays: XE "Overlay:Background" 
1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Sites tab to display the Sites tabbed page.

4. <Click> the corresponding check box or boxes to select one or more site overlays.  The display is updated with the selected overlay(s).  To modify Site Overlay settings, use the associated Select button.

5. <Click> the corresponding Color button(s) to open the Color dialog box XE "Color dialog box"  and change the displayed color of an overlay.

6. <Click> the Close button in the upper right corner to close the Background Overlays dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

Select Airports

The Select Airport dialog box is available from the Sites tabbed page of the Background Overlays dialog box.  This provides options to filter sites, facility types, facility use, ILS, runway lengths, and surface types to be displayed with the airports background overlay.  It also provides the capability to change the style and size of the font for identifying labels.  The Select button to the right of the Airports label displays the Select Airports dialog box.
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Figure 4‑40  Select Airports Dialog Box 

Table 4‑29  Select Airports Dialog Box Description

	Label
	Component
	Purpose

	Enter Airport ID’s To Display
	Text Box 
	Allows the user to enter airport IDs for specific sites.

	Enter Airport ID’s To Display
	Scroll List
	Stores entered airport IDs in alphabetical order for easy reference.

	Add
	Button
	Adds airport IDs entered in the text box to the scroll list and marks the active product.

	Delete
	Button
	Removes highlighted airport IDs from the scroll list and the corresponding marks from the active product.  However, if the facility type check box for that type of site is checked, the mark will still show on the active product.

	Font
	Button
	Displays the Font dialog box to allow changes in style or size of label fonts.

	
	Drop-down List Box
	Allows the user to choose the type of marks used to indicate marked sites.  Auto displays the system default.  Text displays airport IDs.  Points displays dots.

	Facility Type
	Group Label
	Allows the user to select different types of facilities to be marked on the active product.

	Display All Types
	Check Box
	Greys out all other facility type check boxes and marks all facility types on the active product.  When this check box is selected, no filtering is done on Facility Type.

	Airport
	Check Box
	Selects and marks airports on the active product.

	Balloonport
	Check Box
	Selects and marks balloonports on the active product.

	Seaplane Base
	Check Box
	Selects and marks seaplane bases on the active product.

	Gliderport
	Check Box
	Selects and marks gliderports on the active product.

	Heliport
	Check Box
	Selects and marks heliports on the active product.

	STOLPORT
	Check Box
	Selects and marks STOLPORT (short take-off and landing) airports on the active product.

	Ultralight
	Check Box
	Selects and marks ultralight airports on the active product.

	Unknown Type
	Check Box
	Selects and marks unknown facility types on the active product.

	Facility Use
	Group Label
	Allows the user to select types of airports to be marked on the active product.

	Display All Uses
	Check Box
	Greys out all other Facility Use check boxes and marks all facility uses on the active product.  When this check box is selected, no filtering is done on Facility Use.

	Public
	Check Box
	Selects and marks public airports on the active product.

	Private
	Check Box
	Selects and marks private airports on the active product.

	Unknown Use
	Check Box
	Selects and marks facilities with unknown use on the active product.

	Select ILS Only
	Check Box
	Selects only the sites that have Instrument Landing Systems available to be marked on the active product.

	Runway Length
	Group Label
	Allows the user to select only sites with a specific runway length to be marked on the active product.

	RWY
	Check Box
	Selects only the sites that have the specified runway length to be marked on the active product.

	From
	Increment Box
	Specifies the starting point value for the runway length.

	To
	Increment Box
	Specifies the ending point value for the runway length 

	Redraw 
	Button
	Redraws the marks displayed on the product to include only those sites that have the specified runway length.  The RWY check box must be selected.

	Unknown Length
	Check Box
	Selects and marks facilities with unknown runway lengths on the active product.

	Surface Type
	Group Label
	Allows the user to select sites with specific types of airport runway surfaces to be marked on the active product.

	Display All Surfaces
	Check Box
	Greys out all other Surface Type check boxes and marks all surface types on the active product.  When this check box is selected, no filtering is done on Surface Type.

	Portland Cement Concrete
	Check Box
	Selects and marks airports with cement/concrete runways on the active product.

	Asphalt or Bituminous Conc.
	Check Box
	Selects and marks airports with asphalt or bituminous concrete runways on the active product.

	Gravel
	Check Box
	Selects and marks airports with gravel runways on the active product.

	Turf
	Check Box
	Selects and marks airports with turf runways on the active product.

	Dirt
	Check Box
	Selects and marks airports with dirt runways on the active product.

	Snow
	Check Box
	Selects and marks airports with snow runways on the active product.

	Ice
	Check Box
	Selects and marks airports with ice runways on the active product.

	Water
	Check Box
	Selects and marks airports with water runways on the active product.

	Mats
	Check Box
	Selects and marks airports with mat runways on the active product.

	Treated
	Check Box
	Selects and marks airports with treated runways on the active product.

	Unknown Surface
	Check Box
	Selects and marks airports with unknown surface types on the active product.

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Add Specific Airport Background Overlay: XE "Overlay:Background" 
1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Sites tab to display the Sites tabbed page.

4. <Click> the Airports check box.  The display is updated with the airports overlay.

5. <Click> the Select button to the right of the Airports label to display the Select Airports dialog box.

6. Enter the specific airport IDs for additional sites needed in the Enter Airport ID’s To Display text box.

7. <Click> the Add button for each site entered.  The sites are added to the scroll list and marked on the active product.

8. <Click> the Font button to change the font for all airport labels.  The Font dialog box is displayed.

9. <Select> the type of mark to be displayed from the drop-down list box.  Auto displays the system default, Text displays airport IDs, and Points displays dots.

10. <Click> the individual check boxes to specify the type of sites to be marked on the active product.  If no checkbox is chosen for Facility Type, Facility Use, or Surface Type, the only sites that will be marked on the active product are those contained in the scroll list.

11. <Click> the OK button to close the Select Airports dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

Select NAVAIDS

The Select NAVAIDS dialog box is available from the Sites tabbed page of the Background Overlays dialog box.  This provides options to filter NAVAID sites and the types of features offered at those sites to be displayed with the NAVAID  background overlay.  It also provides the capability to change the style and size of the font for identifying labels.  The Select button to the right of the Navigational Aids (NAVAIDS) label displays the Select NAVAIDS dialog box.
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Figure 4‑41  Select NAVAIDS Dialog Box 

Table 4‑30  Select NAVAIDS Dialog Box Description

	Label
	Component
	Purpose

	Enter NAVAID IDs To Display
	Text Box 
	Allows the user to enter NAVAID IDs for specific sites.

	Enter NAVAID IDs To Display
	Scroll List
	Stores entered NAVAID IDs in alphabetical order for easy reference.

	Add
	Button
	Adds NAVAID IDs entered in the text box to the scroll list and marks the active product.

	Delete
	Button
	Removes highlighted NAVAID IDs from the scroll list and the corresponding marks from the active product.

	Font
	Button
	Displays the Font dialog box to allow changes in style or size of label fonts.

	
	Drop-down List Box
	Allows the user to choose the type of marks used to indicate marked sites.  Auto displays the system default.  Text displays NAVAID IDs.  Points displays dots.

	NAVAID Type
	Group Label
	Allows the user to select different types of NAVAIDs to be marked on the active product.

	Display All
	Check Box
	Greys out all other NAVAID Type check boxes and marks all NAVAID types on the active product.  When this check box is selected, no filtering is done on NAVAID Type.

	VORTAC
	Check Boxes
	Selects and marks high, low, and terminal VORTAC facilities on the active product.  These are facilities that offer VOR Azimuth, TACAN Azimuth, and TACAN DME.

	VOR/DME
	Check Box
	Selects and marks high, low, and terminal VOR/DME facilities on the active product.  These are facilities that offer VHF Omni-directional Range with associated distance measuring equipment.

	VOR
	Check Box
	Selects and marks high, low, and terminal VOR facilities on the active product.  These are facilities that offer VHF Omni-directional range providing Azimuth only.

	TACAN
	Check Box
	Selects and marks high, low, and terminal TACAN facilities on the active product.  These are facilities that offer a Tactical Air Navigation system providing Azimuth and slant range distance equipment.

	NDB
	Check Box
	Selects and marks sites that offer a Non-Directional Beacon (NDB).

	NDB/DME
	Check Box
	Selects and marks sites that offer a non-directional beacon with associated distance measuring equipment (NDB/DME).

	Fan Marker
	Check Box
	Selects and marks sites that offer fan marker equipment.

	LFR
	Check Box
	Selects and marks sites that offer low frequency radar (LFR).

	VOT
	Check Box
	Selects and marks sites that offer an FAA VOR Test (VOT) facility.

	UHF/NDB
	Check Box
	Selects and marks sites that offer an ultra high frequency Non-Directional Beacon (UHF/NDB).

	CONSOLAN
	Check Box
	Selects and marks sites that offer a low frequency, long-distance NAVAID (CONSOLAN)used principally for transoceanic navigation 

	Marine NDB
	Check Box
	Selects and marks sites that offer an NDB used primarily for marine surface navigation.

	Marine NDB/DME
	Check Box
	Selects and marks sites that offer an NDB with associated DME used primarily for marine surface navigation.

	Unknown
	Check Box
	Selects sites that are not associated with any specific features.

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Add Specific NAVAID Background Overlay: XE "Overlay:Background" 
1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Sites tab to display the Sites tabbed page.

4. <Click> the Navigational Aids (NAVAIDS) check box.  The display is updated with the NAVAIDS overlay.

5. <Click> the Select button to the right of the Navigational Aids (NAVAIDS) label to display the Select NAVAIDS dialog box.

6. Enter the NAVAID IDs for additional sites needed in the Enter NAVAID ID’s To Display text box.

7. <Click> the Add button for each site entered.  The sites are added to the scroll list and marked on the active product.

8. <Click> the Font button to change the font for all NAVAID labels.  The Font dialog box is displayed.

9. <Select> the type of mark to be displayed from the drop-down list box.  Auto displays the system default, Text displays NAVAID IDs, and Points displays dots.

10. <Click> the individual check boxes to specify the type of NAVAID sites to be marked on the active product.  Unless at least one checkbox for NAVAID Type is chosen, the only sites that will be marked on the active product are those contained in the scroll list.

11. <Click> the OK button to close the Select NAVAIDS dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

Select Radar Sites XE "Radar Sites" \r "D2HBRadar_Sites59" 
The Select Radar Sites dialog box is available from the Sites tabbed page of the Background Overlays XE "Overlay:Background"  dialog box.   This provides options to filter Radar sites to be displayed with the Select Radar Sites background overlay.  It also provides the capability to modify and display Range Rings for each of the radar sites.  The Select button to the right of the Radar Site Locations label displays the Select Radar Sites dialog box.
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Figure 4‑42  Select Radar Sites Dialog Box 

Table 4‑31  Select Radar Sites Dialog Box Description

	Label
	Component
	Purpose

	Display All Radar Sites
	Check Box
	Selects and marks all radar sites on the active product.

	Enter Radar Sites To Display
	Text Box 
	Allows the user to enter radar site IDs for specific sites.

	Enter Radar Sites To Display
	Scroll List
	Stores entered radar site IDs in alphabetical order for easy reference.

	Add
	Button
	Adds the radar site IDs entered in the text box to the scroll list and marks the active product.

	Delete
	Button
	Removes highlighted radar site IDs from the scroll list and the corresponding marks from the active product.

	Font
	Button
	Displays the Font dialog box to allow changes in style or size of label fonts.

	
	Drop-down List Box
	Allows the user to choose the type of marks used to indicate marked sites.  Auto displays the system default.  Text displays radar site IDs.  Points displays dots.

	Range Rings
	Group Label
	Allows the user to select and modify range rings for the selected radar sites to be marked on the active product.

	Display Range Rings
	Check Boxes
	Selects and marks range rings on the active product.  

	Display Polar Angles
	Check Boxes
	Selects and marks polar angles inside the range rings on the active product.  

	Polar Grid Angle
	Increment Box
	Specifies the degree of polar grid angles for display in the range rings on the active product.

	Number of Rings
	Increment Box
	Specifies the number of range rings to be displayed for radar sites.

	Increments (NM)
	Increment Box
	Specifies the increments, in nautical miles, between each displayed range ring for radar sites on the active product.

	Redraw 
	Button
	Redraws the radar range rings displayed on the product to include the changes made in the increment boxes for range rings.

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Add Specific Radar Site Location Background Overlay: XE "Overlay:Background" 
1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Sites tab to display the Sites tabbed page.

4. <Click> the Radar Site Locations check box.  The display is updated with the Radar Site Locations overlay.

5. <Click> the Select button to the right of the Radar Site Locations label to display the Select Radar Sites dialog box.

6. Enter the radar site IDs for additional sites needed in the Enter Radar Sites To Display text box.

7. <Click> the Add button for each site entered.  The sites are added to the scroll list and marked on the active product.

8. <Click> the Font button to change the font for all Radar site labels.  The Font dialog box is displayed.

9. <Select> the type of mark to be displayed from the drop-down list box.  Auto displays the system default, Text displays radar site IDs, and Points displays dots.

10. <Click> the individual check boxes to specify range rings and polar angles to be displayed on the active product.

11. Enter the desired polar grid angles, number of rings, and increments between rings.

12. <Click> the Redraw button to include the changes made in the increment boxes for range rings to be displayed on the active product.

13. <Click> the OK button to close the Select Radar Sites dialog box when all selections are complete

NOTE:
This procedure assumes that a product has been loaded.

Select TAF Reporting Stations XE "TAF Reporting Stations" \r "D2HBTAF_Reportin60"  

The Select TAF Reporting Stations dialog box is available from the Sites tabbed page of the Background Overlays XE "Overlay:Background"  dialog box.   This provides options to filter TAF reporting station sites to be displayed with the Select TAF Reporting Stations background overlay.  The Select button to the right of the TAF Reporting Stations label displays the Select TAF Reporting Stations dialog box.  The full TAF report can be viewed by tool tipping a station.
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Figure 4‑43  Select TAF Reporting Stations  Dialog Box 

Table 4‑32  Select TAF Reporting Stations Dialog Box Description

	Label
	Component
	Purpose

	Display All TAF Reporting Stations
	Check Box
	Selects and marks all TAF reporting stations on the active product. 

	Enter TAF Reporting Stations to Display
	Text Box
	Allows the user to enter TAF IDs for specific sites.

	Enter TAF Reporting Stations to Display
	Scroll List
	Stores entered TAF IDs in alphabetical order for easy reference.

	Add
	Button
	Adds TAF IDs entered in the text box to the scroll list and marks the active product.

	Delete
	Button
	Removes highlighted TAF IDs from the scroll list and the corresponding marks from the active product.

	Font
	Button
	Displays the Font dialog box to allow changes in style or size of label fonts.

	
	Drop-down List Box
	Allows the user to choose the type of marks used to indicate marked sites.  Auto displays the system default.  Text displays TAF IDs.  Points displays dots.

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Add Specific TAF Reporting Stations Background Overlay: XE "Overlay:Route" 
1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Sites tab to display the Sites tabbed page.

4. <Click> the TAF Reporting Stations check box.  The display is updated with the TAF reporting stations overlay.

5. <Click> the Select button to the right of the TAF Reporting Stations label to display the Select TAF Reporting Stations dialog box.

6. Enter the specific TAF IDs for additional sites needed in the Enter TAF Reporting Stations To Display text box.

7. <Click> the Add button for each site entered.  The sites are added to the scroll list and marked on the active product.

8. <Click> the Font button to change the font for all TAF site labels.  The Font dialog box is displayed.

9. <Select> the type of mark to be displayed from the drop-down list box.  Auto displays the system default, Text displays TAF IDs, and Points displays dots.

10. <Click> the OK button to close the Select TAF Reporting Stations dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

Select Surface Observation Stations

The Select Surface Observation Stations dialog box is available from the Sites tabbed page of the Background Overlays dialog box.  This provides options to filter surface observation stations and their corresponding METAR/SPECI data.  In addition to displaying all of the Surface Observation Stations, the overlay can display the altimeter setting for any station that has a current METAR/SPECI report.  The displayed altimeter setting is updated when the workstation receives the updated report.  The full METAR/SPECI report can be viewed by tool tipping a station.  If a SPECI is received, the SPECI will replace the METAR report in the tool tip.  
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Figure 4‑44  Surface Observation Stations Overlay XE "Overlay:Background"  with Altimeter Settings 
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Figure 4‑45  Select Surface Observation Stations Dialog Box

Table 4‑33  Select Surface Observation Stations Dialog Box Description

	Label
	Component
	Purpose

	Display All Surface Observation Stations 
	Check Box
	Selects and marks all surface observation stations on the active product.  However, this will not include stations that have no current METAR/SPECI data if the “Hide Stations with no current METAR/SPECI data” check box is selected.   When this box is not checked, only stations listed in the “As Text” and  “As Points” will be displayed.

	Enter Surface Observation Stations To Display
	Text Box
	Allows the user to enter surface observation station IDs for specific sites.  These sites will always be displayed as text, regardless of any other setting in the dialog box.

	As Text
	Scroll List
	Stores entered surface observation station IDs in alphabetical order for easy reference.  These sites will always be displayed as text regardless of any other setting in the dialog box.  Any station listed in the “As Points” scroll list cannot be added to this list until it is removed from the “As Points” list.

	As Points
	Scroll List
	Stores entered surface observation station IDs in alphabetical order for easy reference.  These sites will always be displayed as points regardless of any other setting in the dialog box.  Any station listed in the “As Text” scroll list cannot be added to this list until it is removed from the “As Text” list.

	Add
	Button
	Adds surface observation station IDs entered into the “As Text:” text box to the corresponding scroll list.  After the site is added to the scroll list, it will be drawn as text regardless of other settings in the dialog box.

	Delete
	Button
	Removes the highlighted site from the “As Text” scroll list.  The station will no longer be drawn as text, but will be drawn based on other settings in the dialog box.

	Add Pt.
	Button
	Adds surface observation station IDs entered in the “As Points:” text box to the corresponding scroll list.  After the site is added to the scroll list, it will be drawn as a point regardless of other settings in the dialog box.

	Delete Pt.
	Button
	Removes the highlighted site from the “As Points:” scroll list.  The station will no longer be drawn as a point, but will be drawn based on other settings in the dialog box.

	Altimeter Display Settings
	Group Label
	These settings control the way surface observation stations are drawn as text.   Only one item may be selected.  These settings will not affect stations drawn as points.

	Hide Altimeter Setting
	Radio Button
	When this radio button is selected, surface observation stations drawn as text will display only the surface observation station ID.

	Display Altimeter Setting with Station Labels
	Radio Button
	When this radio button is selected, surface observation stations drawn as text will display the surface observation station ID and the Altimeter for that station.  If N/A is displayed for the Altimeter, then there is no current METAR/SPECI report for that station.  If NALT is displayed for the Altimeter, there is a current METAR/SPECI report, but it does not contain Altimeter data.  The surface observation station ID and Altimeter setting are separated by a ‘-‘.

	Display Altimeter instead of Station Labels
	Radio Button
	When this radio Button is selected, surface observation stations drawn as text will display only the Altimeter setting for that station.  If N/A is displayed for the Altimeter, then there is no current METAR/SPECI report for that station.  If NALT is displayed for the Altimeter, there is a current METAR/SPECI report, but it does not contain Altimeter data.

	Display text using an opaque background
	Check Box
	When this box is checked, all surface observation stations currently being drawn as text will be drawn with an opaque background.  The background will be the color selected for the overlay.  The text will be drawn in black.  If the box is not checked, all stations being drawn as text will be drawn with a transparent background, and the text will appear in the color selected for the overlay.

	Time Before METAR/SPECI Expires
	Group Label
	The time that METAR/SPECI reports will be considered valid on the current product. 

	Hours and Minutes
	Spin Boxes
	The value can be set from 0 minutes to 8 hours.  METAR/SPECI reports that are older than this value will not be shown, in the tooltip, and the altimeter setting will be drawn as N/A unless it is being hidden.  If the altimeter value is being drawn, and stations with no current data are not being hidden, the altimeter value will be displayed as “N/A”

	Hide stations with no current METAR/SPECI data
	Check Box
	When this box is checked, all surface observation stations without current METAR/SPECI data will be hidden.  The “Time Before METAR/SPECI Expires” value is used to determine if there is current data available for a station.  This will not hide any stations listed in the “As Text” or “As Points” scroll boxes.

	Font
	Button
	Displays the Font dialog box to allow changes in style or size of label fonts.

	(None)
	Drop-down List Box
	Allows the user to choose the type of marks used to indicate selected sites.  Auto displays the system default.  Text displays surface observation station IDs.  Points displays dots.

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Add Specific Surface Observation Stations As Text to the Background Overlay: XE "Overlay:Background" 
1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Sites tab to display the Sites tabbed page.

4. <Click> the Surface Observation Stations check box.  The display is updated with the surface observation stations overlay.

5. <Click> the Select button to the right of the Surface Observation Stations label to display the Select Surface Observation Stations dialog box.

6. Enter the specific surface observation station IDs for additional sites needed in the Enter Surface Observation Stations To Display As Text text box.

7. <Click> the Add button, located under the scroll list, for each site entered.  The sites are added to the scroll list and displayed as text on the active product

8. <Click> the Font button to change the font for all surface observation site labels.  The Font dialog box is displayed.

9. <Click> the OK button to close the Select Surface Observation Stations dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

To Add Specific Surface Observation Stations As Points to the Background Overlay:

1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Sites tab to display the Sites tabbed page.

4. <Click> the Surface Observation Stations check box.  The display is updated with the surface observation stations overlay.

5. <Click> the Select button to the right of the Surface Observation Stations label to display the Select Surface Observation Stations dialog box.

6. Enter the specific surface observation station IDs for additional sites needed in the Enter Surface Observation Stations To Display As Points text box.

7. <Click> the Add Pt. button, located under the scroll list, for each site entered.  The sites are added to the scroll list and displayed as points on the active product

8. <Click> the OK button to close the Select Surface Observation Stations dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

Select Upper Air Stations XE "Upper Air Stations" 
The Select Upper Air Stations dialog box is available from the Sites tabbed page of the Background Overlays XE "Overlay:Background"  dialog box.  This provides options to filter upper air station sites to be displayed with the Select Upper Air Stations background overlay.  The Select button to the right of the Upper Air Sounding Stations label displays the Select Upper Air Stations dialog box.
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Figure 4‑46  Select Upper Air Stations

Table 4‑34  Select Upper Air Stations Dialog Box Description

	Label
	Component
	Purpose

	Display All Upper Air Stations 
	Check Box
	Selects and marks all upper air sounding stations on the active product.

	Enter Upper Air Stations To Display
	Text Box
	Allows the user to enter upper air station IDs for specific sites.

	Enter Upper Air Stations To Display
	Scroll List
	Stores entered upper air station IDs in alphabetical order for easy reference.

	Add
	Button
	Adds upper air station IDs entered in the text box to the scroll list and marks the active product.

	Delete
	Button
	Removes highlighted site upper air station IDs from the scroll list and the corresponding marks from the active product.

	Font
	Button
	Displays the Font dialog box to allow changes in style or size of label fonts.

	
	Drop-down List Box
	Allows the user to choose the type of marks used to indicate marked sites.  Auto displays the system default.  Text displays upper air station IDs.  Points displays dots.

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Add Specific Upper Air Sounding Stations Background Overlay: XE "Overlay:Background" 
1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Sites tab to display the Sites tabbed page.

4. <Click> the Upper Air Sounding Stations check box.  The display is updated with the upper air sounding stations overlay.

5. <Click> the Select button to the right of the Upper Air Sounding Stations label to display the Select Upper Air Stations dialog box.

6. Enter the specific upper air station IDs for additional sites needed in the Enter Upper Air Stations To Display text box.

7. <Click> the Add button for each site entered.  The sites are added to the scroll list and marked on the active product.

8. <Click> the Font button to change the font for all Upper Air Station site labels.  The Font dialog box is displayed.

9. <Select> the type of mark to be displayed from the drop-down list box.  Auto displays the system default, Text displays upper air station IDs, and Points displays dots.

10. <Click> the OK button to close the Select Upper Air Stations dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

Select Synoptic Stations

The Select Synoptic Stations dialog box is available from the Sites tabbed page of the Background Overlays dialog box.  This provides options to filter synoptic station sites to be displayed with the Select Synoptic Stations background overlay.  The Select button to the right of the Synoptic Stations label displays the Select Synoptic Stations dialog box.
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Figure 4‑47  Select Synoptic Stations

Table 4‑35  Select Synoptic Stations Dialog Box Description

	Label
	Component
	Purpose

	Display All Synoptic Stations 
	Check Box
	Selects and marks all synoptic stations on the active product.

	Enter Synoptic Stations To Display
	Text Box
	Allows the user to enter synoptic station IDs for specific sites.

	Enter Synoptic Stations To Display
	Scroll List
	Stores entered synoptic station IDs in alphabetical order for easy reference.

	Add
	Button
	Adds synoptic station IDs entered in the text box to the scroll list and marks the active product.

	Delete
	Button
	Removes highlighted synoptic station IDs from the scroll list and the corresponding marks from the active product.

	Font
	Button
	Displays the Font dialog box to allow changes in style or size of label fonts.

	
	Drop-down List Box
	Allows the user to choose the type of marks used to indicate marked sites.  Auto displays the system default.  Text displays synoptic station IDs.  Points displays dots.

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Add Specific Synoptic Stations Background Overlay: XE "Overlay:Background" 
1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Sites tab to display the Sites tabbed page.

4. <Click> the Synoptic Stations check box.  The display is updated with the synoptic stations overlay.

5. <Click> the Select button to the right of the Synoptic Stations label to display the Select Synoptic Stations dialog box.

6. Enter the specific synoptic station IDs for additional sites needed in the Enter Synoptic Stations To Display text box.

7. <Click> the Add button for each site entered.  The sites are added to the scroll list and marked on the active product.

8. <Click> the Font button to change the font for all Synoptic Station site labels.  The Font dialog box is displayed.

9. <Select> the type of mark to be displayed from the drop-down list box.  Auto displays the system default, Text displays synoptic station IDs, and Points displays dots.

10. <Click> the OK button to close the Select Synoptic Stations dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

GPS/RAIM XE "GPS/RAIM" \r "D2HBGPS_RAIM70" 
The GPS/RAIM Options dialog box is available from the Sites tabbed page of the Background Overlays dialog box.  This provides options to filter sites displayed with the GPS/RAIM background overlay.  Additionally, it provides options to specify a time period to visually decipher GPS satellite outages at sites.  Time periods can be set for any time range up to 54 hours in advance.  The Select button to the right of the GPS/RAIM label displays the GPS/RAIM Options dialog box.
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Figure 4‑48  GPS/RAIM Options Dialog Box

Table 4‑36  Select GPS/RAIM Options Dialog Box Description

	Label
	Component
	Purpose

	Enter Airport ID’s To Display
	Text Box 
	Allows the user to enter airport IDs for specific sites.

	Enter Airport ID’s To Display
	Scroll List
	Stores entered airport IDs in alphabetical order for easy reference.

	Add
	Button
	Adds site airport IDs entered in the text box to the scroll list and marks the active product.

	Delete
	Button
	Removes highlighted site airport IDs from the scroll list and the corresponding marks from the active product.

	Font
	Button
	Displays the Font dialog box to allow changes in style or size of label fonts.

	
	Drop-down List Box
	Allows the user to choose the type of marks used to indicate marked sites.  Auto displays the system default.  Text displays airport IDs.  Points displays the selected icon.

	Coverages
	Group Label
	Allows the user to select and modify the icon which denotes GPS coverage for the selected sites to be marked on the active product.

	Color Buttons
	Button
	Displays the selected or default color for the corresponding coverage icon and opens the Color dialog box when selected.

	Full Coverage 
	Spin Box 
	Specifies the shape of icon for full coverage.  Full coverage denotes GPS which has no satellite outage interval during the user defined period.

	Partial Coverage 
	Spin Box
	Specifies the shape of icon for partial coverage.  Partial coverage denotes GPS which have a satellite outage interval during the user defined period.

	No Coverage
	Spin Box
	Specifies the shape of icon for no coverage.  No coverage denotes GPS which have a constant interval of satellite outage during the user defined period.

	Unknown Coverage
	Spin Box
	Specifies the shape of icon for unknown coverage.  Unknown coverage denotes sites where GPS coverage is unknown during the user defined period.

	Start Offset
	Increment Box
	Specifies the Start Offset time in 5 minute increments

	End Offset
	Increment Box
	Specifies the End Offset time in 5 minute increments

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Add Specific GPS/RAIM Background Overlay: XE "Overlay:Background" 
1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Sites tab to display the Sites tabbed page.

4. <Click> the GPS/RAIM check box.  The display is updated with the GPS/RAIM overlay.

5. <Click> the Select button to the right of the GPS/RAIM label to display the GPS/RAIM Options dialog box.

6. Enter the specific airport IDs for additional sites needed in the Enter Airport ID's To Display text box.

7. <Click> the Add button for each site entered.  The sites are added to the scroll list and marked on the active product.

8. <Click> the Font button to change the font for all GPS/RAIM site labels.  The Font dialog box is displayed.

9. <Select> the type of mark to be displayed from the drop-down list box.  Auto displays the system default, Text displays airport IDs, and Points displays dots.

10. <Click> the corresponding Color button(s) to open the Color dialog box XE "Color dialog box"  and change the displayed color of a coverage icon.

11. <Click> the individual spin boxes to specify the type of coverage icons to be used on the active product.

12. <Click> the individual spin boxes to specify the start and end offset times.

13. <Click> the OK button to close the GPS/RAIM Options dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

4.4.1.4  XE "Aero" \r "D2HBAero71" Aero

The Aero (Aeronautical) tabbed page of the Background Overlays dialog box provides the options to designate Jet Routes, Victor Airways, Military Training Routes, Oceanic Routes, and Special Use Airspace to be displayed with the Aero background overlay.  Each of these options can be customized to include specific sites and routes.  This tabbed page also provides the capability to mark holding pattern airspace.

When a site or route is marked, holding the cursor over the mark displays any additional information in a fly-over text box.  If a product becomes too cluttered with overlay marks, zooming in on an area will help separate the individual marks.
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Figure 4‑49  Aero (Aeronautical) Overlay
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Figure 4‑50  Aero (Aeronautical) Tabbed Page

Table 4‑37  Aero (Aeronautical) Tabbed Page Description

	Label
	Component
	Purpose

	Color Buttons
	Button
	Displays the selected or default color for the corresponding overlay and opens the Color dialog box when selected.

	Major Jet Routes
	Check Box
	Selects major Jet Routes to be displayed.

	Major Victor Airways
	Check Box
	Selects major Victor Airways to be displayed.

	Military Training Routes XE "Military Training Route" 
	Check Box
	Selects Military Training Routes to be displayed.

	Oceanic Routes XE "Oceanic Routes" 
	Check Box
	Selects oceanic routes to be displayed.

	Special Use Airspace
	Check Box
	Selects special use airspace to be displayed.

	Holding Pattern Airspace
	Check Box
	Selects holding pattern airspace to be displayed.

	Select
	Buttons
	Displays the dialog box for making changes to the respective overlay settings.


To Add Aeronautical Background Overlays:

1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Aero tab to display the Aero tabbed page.

4. <Click> the corresponding check box or boxes to select one or more aeronautical overlays. XE "Overlay:Background"   The display is updated with the selected overlay(s).  To modify settings, use the associated Select button.

5. <Click> the corresponding Color button(s) to open the Color dialog box XE "Color dialog box"  and change the displayed color of an overlay.

6. <Click> the Close button in the upper right corner to close the Background Overlays dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

Select Jet Routes XE "Jet Routes" \r "D2HBJet_Routes74" 
The Select Jet Routes dialog box is available from the Aero tabbed page of the Background Overlays dialog box.  This provides options to filter Jet Routes and NAVAID facilities labels displayed with the Jet Routes background overlay.  It also provides the capability to change the style and size of the font for identifying labels.  The Select button to the right of the Major Jet Routes label displays the Select Jet Routes dialog box.
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Figure 4‑51  Select Jet Routes Dialog Box

Table 4‑38  Select Jet Routes Dialog Box Description

	Label
	Component
	Purpose

	Display All Jet Routes 
	Check Box
	Selects and marks all major Jet Routes on the active product.

	Enter Jet Routes To Display
	Text Box
	Allows the user to enter jet route IDs for specific routes.

	Enter Jet Routes To Display
	Scroll List
	Stores entered jet route IDs in alphabetical order for easy reference.

	Add
	Button
	Adds jet route IDs entered in the text box to the scroll list and marks the active product.

	Delete
	Button
	Removes highlighted jet route IDs from the scroll list and the corresponding marks from the active product.

	Font
	Button
	Displays the Font dialog box to allow changes in style or size of label fonts.

	(None)
	Drop-down List Box
	Allows the user to choose the type of marks used to indicate marked sites.  Auto displays the system default.  Text displays jet route IDs.  Points displays dots.  Invisible removes identifying marks.

	Display NAVAID Facility/Fix Names 
	Check Box
	Selects and marks all NAVAID facilities/fixes on the active product.

	Select NAVAID Facility/Fix Type 
	Group Label
	Allows the user to select different types of NAVAID facilities/fixes to be marked on the active product.

	VORTAC
	Check Boxes
	Selects and marks VORTAC facilities on the active product.  These are facilities that offer VOR Azimuth, TACAN Azimuth, and TACAN DME.

	VOR/DME
	Check Box
	Selects and marks VOR/DME facilities on the active product.  These are facilities that offer VHF Omni-directional Range with associated distance measuring equipment.

	Marine NDB
	Check Box
	Selects and marks sites that offer an NDB used primarily for marine surface navigation.

	NDB/DME
	Check Box
	Selects and marks sites that offer a non-directional beacon with associated distance measuring equipment (NDB/DME).

	NDB
	Check Box
	Selects and marks sites that offer a Non-Directional Beacon (NDB).

	VOR
	Check Box
	Selects and marks VOR facilities on the active product.  These are facilities that offer VHF Omni-directional range providing Azimuth only.

	ARTCC
	Check Box
	Selects and marks Air Route Traffic Control Centers on the active product.

	MIL
	Check Box
	Selects and marks MIL sites on the active product.

	TURN-PT
	Check Box
	Selects and marks turn-point sites on the active product.

	AWY-INTXN
	Check Box
	Selects and marks airway intersection sites on the active product.

	REP
	Check Box
	Selects and marks REP sites on the active product.

	COORDN
	Check Box
	Selects and marks COORDN sites on the active product.

	Way Point
	Check Box
	Selects and marks way point sites on the active product.

	Unknown
	Check Box
	Selects and marks unknown sites on the active product.  

	Display Label Text 
	Group Label
	Allows the user to select identification labels for NAVAID sites and Jet Routes.

	NAVAID ID
	Check Box
	Selects and marks NAVAID identification labels on the active product.

	Route ID
	Check Box
	Selects and marks jet route identification labels on the active product.

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Add Specific Jet Route Background Overlay: XE "Overlay:Background" 
1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Aero XE "Aero"  tab to display the Aero tabbed page.

4. <Click> the Major Jet Routes check box.  The display is updated with the Major Jet Routes overlay.

5. <Click> the Select button to the right of the Major Jet Routes label to display the Select Jet Routes dialog box.

6. Enter the specific jet route IDs for additional routes needed in the Enter Jet Routes To Display text box.

7. <Click> the Add button for each route entered.  The routes are added to the scroll list and marked on the active product.

8. <Click> the Font button to change the font for all identification labels.  The Font dialog box is displayed.

9. <Select> the type of mark to be displayed from the drop-down list box.  Auto displays the system default, Text displays jet route IDs, Points displays dots, and Invisible removes identifying marks.

10. <Click> the Display NAVAID Facility/Fix Names check box to select and mark NAVAID facilities/fixes on the active product.

11. <Click> the individual Select NAVAID Facility/Fix Types check boxes to specify which NAVAIDs to display on the active product.

12. <Click> the Display Label Text check boxes to display NAVAID and/or route identification labels.

13. <Click> the OK button to close the Select Jet Routes dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

Select Victor Airways XE "Victor Airways" \r "D2HBVictor_Airwa76" 
The Select Victor Airways dialog box is available from the Aero tabbed page of the Background Overlays dialog box.  This provides options to filter Victor Airway and NAVAID facilities labels displayed with the Victor Airways background overlay.  It also provides the capability to change the style and size of the font for identifying labels.  The Select button to the right of the Major Victor Airways label displays the Select Victor Airways dialog box.
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Figure 4‑52  Select Victor Airways Dialog Box

Table 4‑39  Select Victor Airways Dialog Box Description

	Label
	Component
	Purpose

	Display All Victor Airways 
	Check Box
	Selects and marks all major Victor Airways on the active product.

	Enter Victor Airways To Display
	Text Box
	Allows the user to enter Victor Airway IDs for specific airways.

	Enter Victor Airways To Display
	Scroll List
	Stores entered Victor Airway IDs in alphabetical order for easy reference.

	Add
	Button
	Adds Victor Airway ID entered in the text box to the scroll list and marks the active product.

	Delete
	Button
	Removes highlighted Victor Airway IDs from the scroll list and the corresponding marks from the active product.

	Font
	Button
	Displays the Font dialog box to allow changes in style or size of label fonts.

	
	Drop-down List Box
	Allows the user to choose the type of marks used to indicate marked sites.  Auto displays the system default.  Text displays Victor Airway IDs.  Points displays dots.  Invisible removes identifying marks.

	Display NAVAID Facility/Fix Names 
	Check Box
	Selects and marks all NAVAID facilities/fixes on the active product.

	Select NAVAID Facility/Fix Type 
	Group Label
	Allows the user to select different types of NAVAID facilities/fixes to be marked on the active product.

	VORTAC
	Check Boxes
	Selects and marks VORTAC facilities on the active product.  These are facilities that offer VOR Azimuth, TACAN Azimuth, and TACAN DME.

	VOR/DME
	Check Box
	Selects and marks VOR/DME facilities on the active product.  These are facilities that offer VHF Omni-directional Range with associated distance measuring equipment.

	Marine NDB
	Check Box
	Selects and marks sites that offer an NDB used primarily for marine surface navigation.

	NDB/DME
	Check Box
	Selects and marks sites that offer a non-directional beacon with associated distance measuring equipment (NDB/DME).

	NDB
	Check Box
	Selects and marks sites that offer a Non-Directional Beacon (NDB).

	VOR
	Check Box
	Selects and marks VOR facilities on the active product.  These are facilities that offer VHF Omni-directional range providing Azimuth only.

	ARTCC
	Check Box
	Selects and marks Air Route Traffic Control Centers on the active product.

	MIL
	Check Box
	Selects and marks MIL sites on the active product.

	TURN-PT
	Check Box
	Selects and marks turn-point sites on the active product.

	AWY-INTXN
	Check Box
	Selects and marks airway intersection sites on the active product.

	REP
	Check Box
	Selects and marks REP sites on the active product.

	COORDN
	Check Box
	Selects and marks COORDN sites on the active product.

	Way Point
	Check Box
	Selects and marks way point sites on the active product.

	Unknown
	Check Box
	Selects and marks unknown sites on the active product.  

	Display Label Text 
	Group Label
	Allows the user to select identification labels for NAVAID sites and Victor Airways.

	NAVAID ID
	Check Box
	Selects and marks NAVAID identification labels on the active product.

	Airway ID
	Check Box
	Selects and marks Victor Airways identification labels on the active product.

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Add Specific Victor Airway Background Overlay: XE "Overlay:Background" 
1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box

3. <Click> the Aero XE "Aero" \r "D2HBAero78"  tab to display the Aero tabbed page.

4. <Click> the Major Victor Airways check box.  The display is updated with the Major Victor Airways overlay.

5. <Click> the Select button to the right of the Major Victor Airways label to display the Select Victor Airways dialog box.

6. Enter the specific Victor airway IDs for additional airways needed in the Enter Victor Airways To Display text box.

7. <Click> the Add button for each airway entered.  The airways are added to the scroll list and marked on the active product.

8. <Click> the Font button to change the font for all identification labels.  The Font dialog box is displayed.

9. <Select> the type of mark to be displayed from the drop-down list box.  Auto displays the system default, Text displays Victor airway IDs, Points displays dots, and Invisible removes identifying marks.

10. <Click> the Display NAVAID Facility/Fix Names check box to select and mark NAVAID facilities/fixes on the active product.

11. <Click> the individual Select NAVAID Facility/Fix Types check boxes to specify which NAVAIDs to display on the active product.

12. <Click> the Display Label Text check boxes to display NAVAID and/or airway identification labels.

13. <Click> the OK button to close the Select Victor Airways XE "Victor Airways"  dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

Select Military Training Routes (MTR XE "Military Training Route" \r "D2HBMTR80" )

The Select MTR Routes dialog box is available from the Aero tabbed page of the Background Overlays XE "Overlay:Background"  dialog box.  This provides options to filter Military Training Routes and the type of route to be displayed with the MTR Routes background overlay.  It also provides the capability to change the style and size of the font for identifying labels.  Further filtering based upon the current route status as well as the selection of colors for the different statuses may also be performed from this dialog.  The Select button to the right of the Military Training Routes label displays the Select MTR Routes dialog box.
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Figure 4‑53  Select MTR Routes Dialog Box

Table 4‑40  Select MTR Routes Dialog Box Description

	Label
	Component
	Purpose

	Enter Military Training Routes To Display
	Text Box
	Allows the user to enter Military Training Route IDs for specific MTRs.

	Enter Military Training Routes To Display
	Scroll List
	Stores entered MTR IDs in alphabetical order for easy reference.

	Add
	Button
	Adds MTR IDs entered in the text box to the scroll list and marks the active product.

	Delete
	Button
	Removes highlighted MTR IDs from the scroll list and the corresponding marks from the active product.

	Font
	Button
	Displays the Font dialog box to allow changes in style or size of label fonts.

	
	Drop-down List Box
	Allows the user to choose the type of marks used to indicate marked sites.  Auto displays the system default.  Text displays MTR IDs.  Points displays dots.  Invisible removes identifying marks.

	Route Type 
	Group Label
	Allows the user to select different types of MTRs to be marked on the active product.

	IR
	Check Box
	Selects and marks instrument rating routes on the active product.

	VR
	Check Box
	Selects and marks visual rating routes on the active product.

	Route Status
	Group Label
	Allows the user to select MTRs with different statuses to be marked on the active product.

	Color Buttons
	Button
	Displays the selected or default color for the corresponding route status and opens the Color dialog box when selected.

	Inactive
	Check Box
	Selects and marks routes which are currently Inactive.

	Pending
	Check Box
	Selects and marks routes which are currently Pending.1,2  Scheduling data has been entered for these routes but has not yet been processed.

	Waiting
	Check Box
	Selects and marks routes which are currently Waiting.1,2  Scheduling data has been processed for these routes but the start time has not yet occurred.

	Hot
	Check Box
	Selects and marks routes which are currently Hot. 1

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


1 Any route which is drawn as Pending, Waiting, or Hot has an associated Special Use Airspace (SUA) report.  To display this report, place the mouse cursor over a displayed route, and the report will appear in the tooltip.  Also, any future reports for that route will be displayed in successive lines in the tooltip.  The format of the report is described in the Special Use Airspace Schedule Data Format Description Appendix.

2 Any route may have multiple associated reports.  The route will be drawn using only the status of the report with the next effective time.

To Add Specific Military Training Routes Background Overlay: XE "Overlay:Background" 
1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Aero tab to display the Aero tabbed page.

4. <Click> the Military Training Routes check box.  The display is updated with the Military Training Routes overlay.

5. <Click> the Select button to the right of the Military Training Routes label to display the Select MTR Routes dialog box.

6. Enter the specific Military Training Route IDs for additional routes needed in the Military Training Routes To Display text box.

7. <Click> the Add button for each route entered.  The routes are added to the scroll list and marked on the active product.

8. <Click> the Font button to change the font for all identification labels.  The Font dialog box is displayed.

9. <Select> the type of mark to be displayed from the Drop-down list box.  Auto displays the system default, Text displays Military Training Route IDs, Points displays dots, and Invisible removes identifying marks.

10. <Click> the IR check box to select and mark instrument rating routes on the active product.

11. <Click> the VR check box to select and mark visual rating routes on the active product.

12. <Click> the OK button to close the Select MTR Routes dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

Select Oceanic Routes XE "Oceanic Routes" \r "D2HBOceanic_Rout82" 
The Select Oceanic Routes dialog box is available from the Aero tabbed page of the Background Overlays XE "Overlay:Background"  dialog box.  This provides options to filter oceanic routes and the type of route to be displayed with the Oceanic Routes background overlay.  It also provides the capability to change the style and size of the font for identifying labels.  The Select button to the right of the Oceanic Routes label displays the Select Oceanic Routes dialog box.
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Figure 4‑54  Select Oceanic Routes Dialog Box

Table 4‑41  Select Oceanic Routes Dialog Box Description

	Label
	Component
	Purpose

	Enter Oceanic Routes To Display
	Text Box
	Allows the user to enter oceanic route IDs for specific Oceanic Routes.

	Enter Oceanic Routes To Display
	Scroll List
	Stores entered oceanic route IDs in alphabetical order for easy reference.

	Add
	Button
	Adds oceanic route IDs entered in the text box to the scroll list and marks the active product.

	Delete
	Button
	Removes highlighted oceanic route IDs from the scroll list and the corresponding marks from the active product.

	Font
	Button
	Displays the Font dialog box to allow changes in style or size of label fonts.

	
	Drop-down List Box
	Allows the user to choose the type of marks used to indicate marked sites.  Auto displays the system default.  Text displays oceanic route IDs.  Points displays dots.  Invisible removes identifying marks.

	Route Type 
	Group Label
	Allows the user to select different types of oceanic routes to be marked on the active product.

	Oceanic
	Check Box
	Selects and marks oceanic routes, with the exception of Atlantic, Pacific, and Domestic routes, on the active product.

	Atlantic
	Check Box
	Selects and marks Atlantic routes on the active product.

	Pacific
	Check Box
	Selects and marks Pacific routes on the active product.

	Domestic
	Check Box
	Selects and marks Domestic routes on the active product.

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Add Specific Oceanic Routes Background Overlay: XE "Overlay:Background" 
1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Aero tab to display the Aero tabbed page.

4. <Click> the Oceanic Routes check box.  The display is updated with the Oceanic Routes overlay.

5. <Click> the Select button to the right of the Oceanic Routes label to display the Select Oceanic Routes dialog box.

6. Enter the specific oceanic route IDs for additional routes needed in the Enter Oceanic Routes To Display text box.

7. <Click> the Add button for each route entered.  The routes are added to the scroll list and marked on the active product.

8. <Click> the Font button to change the font for all identification labels.  The Font dialog box is displayed. 

9. <Select> the type of mark to be displayed from the drop-down list box.  Auto displays the system default, Text displays oceanic route IDs, Points displays dots, and Invisible removes identifying marks.

10. <Click> the Oceanic check box to select and mark oceanic routes, with the exception of Atlantic, Pacific, and Domestic routes, on the active product.

11. <Click> the Atlantic check box to select and mark Atlantic routes on the active product.

12. <Click> the Pacific check box to select and mark Pacific routes on the active product.

13. <Click> the Domestic check box to select and mark Domestic routes on the active product.
14. <Click> the OK button to close the Select Oceanic Routes dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

Select Special Use Airspace

The Select Special Use Airspace dialog box is available from the Aero tabbed page of the Background Overlays XE "Overlay:Background"  dialog box.  This provides options to filter special use airspace and the type of special use airspace to be displayed with the Special Use Airspace background overlay.  Further filtering based upon the current airspace status as well as the selection of colors for the different statuses may also be performed from this dialog box.  The Select button to the right of the Special Use Airspace label displays the Select Special Use Airspace dialog box.
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Figure 4‑55  Select Special Use Airspace Dialog Box

Table 4‑42  Select Special Use Airspace Dialog Box Description

	Label
	Component
	Purpose

	Enter Names of Airspaces To Display
	Text Box
	Allows the user to enter special use airspace IDs for specific airspace.

	Enter Names of Airspaces To Display
	Scroll List
	Stores entered special use airspace IDs in alphabetical order for easy reference.

	Add
	Button
	Adds special use airspace IDs entered in the text box to the scroll list and marks the active product.

	Delete
	Button
	Removes highlighted special use airspace IDs from the scroll list and the corresponding marks from the active product.

	Airspace Type
	Group Label
	Allows the user to select different types of airspace to be marked on the active product.

	Alert Area
	Check Box
	Selects and marks alert airspace on the active product.

	Military Operation Area
	Check Box
	Selects and marks military operation airspace on the active product.

	Prohibited Area
	Check Box
	Selects and marks prohibited airspace on the active product.

	Restricted Area
	Checkbox
	Selects and marks restricted airspace on the active product.

	Warning Area
	Checkbox
	Selects and marks warning airspace on the active product.

	Airspace Status
	Group Label
	Allows the user to select airspaces with different statuses to be marked on the active product.

	Color Buttons
	Button
	Displays the selected or default color for the corresponding airspace status and opens the Color dialog box when selected.

	Inactive
	Check Box
	Selects and marks airspaces which are currently Inactive.

	Pending
	Check Box
	Selects and marks airspaces which are currently Pending.1,2  Scheduling data has been entered for these airspaces but has not yet been processed.

	Waiting
	Check Box
	Selects and marks airspaces which are currently Waiting.1,2  Scheduling data has been processed for these airspaces but the start time has not yet occurred.

	Hot
	Check Box
	Selects and marks airspaces which are currently Hot.1

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


1 Any airspace which is drawn as Pending, Waiting, or Hot has an associated Special Use Airspace (SUA) report.  To display this report, place the mouse cursor over a displayed airspace, and the report will appear in the tooltip.  Also, any future reports for that airspace will be displayed in successive lines in the tooltip.  The format of the report is described in the Special Use Airspace Schedule Data Format Description Appendix. 

2 Any airspace may have multiple associated reports.  The airspace will be drawn using only the status of the report with the next effective time.

To Add Specific Special Use Airspace Background Overlay: XE "Overlay:Background" 
1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Aero tab to display the Aero tabbed page.

4. <Click> the Special Use Airspace check box.  The display is updated with the Special Use Airspace overlay.

5. <Click> the Select button to the right of the Special Use Airspace label to display the Select Special Use Airspace dialog box.

6. Enter the specific special use airspace IDs for additional airspace needed in the Enter Names of Airspaces To Display text box.

7. <Click> the Add button for each airspace entered.  The airspace is added to the scroll list and marked on the active product.

8. <Click> an Airspace Type check box to select and mark specific types of airspace on the active product.

9. <Click> the OK button to close the Select Special Use Airspace dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

Holding Pattern Airspace XE "Holding Pattern Airspace" 
The Holding Pattern Airspace option is available from the Aero tabbed page of the Background Overlays dialog box.  This is used to mark the outside boundary lines for the airspace designated for circling until clearance for landing is received.

NOTE:  This procedure assumes that a product has been loaded.

To Add Holding Pattern Airspace Overlays:

1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Aero tab to display the Aero tabbed page.

4. <Click> the Holding Pattern Airspace check box.  The display is updated with the selected overlay(s).

5. <Click> the corresponding Color button(s) to open the Color dialog box XE "Color dialog box"  and change the displayed color of the overlay XE "Overlay:Background"  currently selected in the list overlay.

6. <Click> the Close button in the upper right corner to close the Background Overlays dialog box when all selections are complete.

4.4.1.5  XE "Transportation" \r "D2HBTransportati86" Transportation

The Transportation tabbed page of the Background Overlays dialog box provides the options to mark interstate highways and United States routes.  Each of these options can be customized to include specific routes.  It also provides the capability to mark railroads.

When a product is marked, holding the cursor over the mark displays any additional information in a fly-over text box.  If a product becomes too cluttered with overlay marks, zooming in on an area will help separate the individual marks.
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Figure 4‑56  Transportation Overlay
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Figure 4‑57  Transportation Tabbed Page

Table 4‑43  Transportation Tabbed Page Description

	Label
	Component
	Purpose

	Color Buttons
	Button
	Displays the selected or default color for the corresponding overlay.  Opens the Color dialog box when selected.

	Interstate Highways
	Check Box
	Selects the interstate highways overlay to be displayed.

	U.S. Routes
	Check Box
	Selects the U.S. routes overlay to be displayed.

	Railroads
	Check Box
	Selects the railroads overlay to be displayed.

	Select
	Buttons
	Displays the dialog box for making changes to the respective overlay settings.


To Add Transportation Background Overlays:

1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Transportation tab to display the Transportation tabbed page.

4. <Click> the corresponding check box or boxes to select one or more Transportation overlays.  The display is updated with the selected overlay(s).  To modify settings, use the associated Select button.

5. <Click> the corresponding Color button(s) to open the Color dialog box and change the displayed color of an overlay.

6. <Click> the Close button in the upper right corner to close the Background Overlays dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

Select Interstate Highways XE "Interstate Highways" \r "D2HBInterstate_H87" 
The Select Interstate Highways dialog box is available from the Transportation tabbed page of the Background Overlays XE "Overlay:Background"  dialog box.  This provides options to filter interstate highways to be displayed with the Interstate Highways background overlay.  The Select button to the right of the Interstate Highways label displays the Select Interstate Highways dialog box.
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Figure 4‑58  Select Interstate Highways Dialog Box
Table 4‑44  Select Interstate Highways Dialog Box Description

	Label
	Component
	Purpose

	Display All Interstate Highways 
	Check Box
	Selects and marks all interstate highways on the active product.

	Enter Interstate Highways To Display
	Text Box
	Allows the user to enter interstate highway IDs for specific interstate highways.  The format for entering the interstate highway IDs is the letter I followed by the number of the interstate (e.g. I95).

	Enter Interstate Highways To Display
	Scroll List
	Stores entered interstate highway IDs in alphabetical order for easy reference.

	Add
	Button
	Adds interstate highway IDs entered in the text box to the scroll list and marks the active product.

	Delete
	Button
	Removes highlighted interstate highway IDs from the scroll list and the corresponding marks from the active product.

	Font
	Button
	Displays the Font dialog box to allow changes in style or size of fonts.

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Add Specific Interstate Highway Background Overlay: XE "Overlay:Background" 
1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Transportation tab to display the Transportation tabbed page.

4. <Click> the Interstate Highways check box.  The display is updated with the Interstate Highways overlay.

5. <Click> the Select button to the right of the Interstate Highways label to display the Select Interstate Highways dialog box.

6. Enter the specific interstate highway IDs for additional highways needed in the Enter Interstate Highways To Display text box.  The format for entering the interstate highway IDs is the letter "I" followed by the number of the interstate.

7. <Click> the Add button for each highway entered.  The highway is added to the scroll list and marked on the active product.

8. <Click> the Font button to change the font for all interstate highway IDs.  The Font dialog box is displayed.

9. <Click> the OK button to close the Select Interstate Highways dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

Select State Routes XE "State Routes" 
The Select State Routes dialog box is available from the Transportation tabbed page of the Background Overlays dialog box.  This provides options to filter U.S. Routes to be displayed with the State Routes background overlay.  The Select button to the right of the U.S. Routes label displays the Select State Routes dialog box.
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Figure 4‑59  Select State Routes Dialog Box

Table 4‑45  Select State Routes Dialog Box Description

	Label
	Component
	Purpose

	Display All U.S. Routes 
	Check Box
	Selects and marks all U.S. routes on the active product.

	Enter U.S. Routes To Display
	Text Box
	Allows the user to enter US route IDs for specific U.S. routes.  The format for entering the US route IDs is the letter U followed by the number of the route (e.g. U1).

	Enter U.S. Routes To Display
	Scroll List
	Stores entered US route IDs in alphabetical order for easy reference.

	Add
	Button
	Adds US route IDs entered in the text box to the scroll list and marks the active product.

	Delete
	Button
	Removes highlighted US route IDs from the scroll list and the corresponding marks from the active product.

	Font
	Button
	Displays the Font dialog box to allow changes in style or size of fonts.

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Add Specific U.S. Route Background Overlay: XE "Overlay:Background" 
1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Transportation XE "Transportation"  tab to display the Transportation tabbed page.

4. <Click> the U.S. Routes check box.  The display is updated with the U.S. Routes overlay. XE "Overlay:Background" 
5. <Click> the Select button to the right of the U.S. Routes label to display the Select State Routes dialog box.

6. Enter the specific US route IDs for additional routes needed in the Enter U.S. Routes To Display text box.  The format for entering the US route IDs is the letter "U" followed by the number of the route.

7. <Click> the Add button for each route entered.  The route is added to the scroll list and marked on the active product.

8. <Click> the Font button to change the font for all identification labels.  The Font dialog box is displayed

9. <Click> the OK button to close the Select State Routes dialog box when all selections are complete.

NOTE:
This procedure assumes that a product has been loaded.

Railroads XE "Railroads" 
The Railroads option is available from the Transportation tabbed page of the Background Overlays dialog box.  This is used to mark railroad lines for display with the Railroads background overlay.

The steps for marking railroad lines for display with the Railroads background overlay are defined in the "Add Transportation Background Overlays" paragraph. 

To Add Railroads Background Overlays:

1. <Click> Overlay on the menu bar.

2. <Select> the Background Overlays menu option to display the Background Overlays dialog box.

3. <Click> the Transportation tab to display the Transportation tabbed page.

4. <Click> the Railroads check box.  The display is updated with the selected overlay(s).

5. <Click> the corresponding Color button(s) to open the Color dialog box XE "Color dialog box"  and change the displayed color of the overlay currently selected in the list overlay.

6. <Click> the Close button in the upper right corner to close the Background Overlays dialog box when all selections are complete.

NOTE:  This procedure assumes that a product has been loaded.

4.4.2  XE "Clear Flight Plan" \r "D2HBClear_Flight90" Clear Flight Plan

The Clear Flight Plan menu option, available from the Overlay menu, removes a displayed flight plan route from the active product.  This option is only available when flight plan route coordinates have been graphically displayed on a current product.
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Figure 4‑60  Product with Displayed Flight Plan XE "Flight Plan:Display" 
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Figure 4‑61  Product with Removed Flight Plan (Clear Flight Plan)

To Clear a Displayed Flight Plan:

1. <Click> Overlay XE "Overlay:Flight Plan"  on the menu bar.

2. <Select> Clear Flight Plan.  The displayed flight plan is removed from the product.

NOTE:
This procedure assumes that a Flight Plan has been displayed from WIND.
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4.5 Control

The Control menu provides an interface for displaying active products by time.  The Control menu consists of the Select Product Time to View, Request Latest Product, XE "Request Latest Product" \r "D2HBRequest_Late95"  View Oldest Product, View Previous Product, View Next Product, View Latest Product, Automatic Update, XE "Automatic Update"  and Audible Notification XE "Audible Notification"  options.  The Control menu is only available after a current product is opened.
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Figure 4‑62  Control Menu

To Display the Control Menu:

1. <Click> Control on the menu bar.

NOTE:
This procedure assumes that a product has been loaded.

4.5.1 Select Product Time to View

When the download properties of a product have been modified, and multiple versions of the product have been downloaded to the local disk, a user can select specific product times to view.  The Select Product Time to View menu option, available from the Control menu, displays the Product Times dialog box.  The Product Times dialog box provides the capability to select a specific product time, from a list of stored versions of the product, for view in the active window.  The product times are listed by day of the week, date, and GMT.
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Figure 4‑63  Product Times Dialog Box

Table 4‑46  Product Times Dialog Box Description

	Label
	Component
	Purpose

	Product Times
	List Box
	Displays a list of available stored product versions.

	Load
	Button
	Displays the product by the selected time and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.


To View a Product by Time:

1. <Click> Control on the menu bar.

2. <Select> the Select Product Time To View menu option to display the Product Times dialog box.

3. <Select> the desired Product Time from the list box.

4. <Click> the Load button to display the current product at the time(s) selected.

NOTE:
This procedure assumes that a product has been loaded.

4.5.2 Request Latest Product

The Request Latest Product menu option, available from the Control menu, provides the capability to view the most recent available version of a product.  When this menu option is selected, the product displayed in the active window will be updated with the newest available version of the product.

To Request the Most Recent Product Version:

1. <Click> Control on the menu bar.

2. <Select> the Request Latest Product option.  The most recent product version is displayed in the active window.

NOTE:
This procedure assumes that a product has been loaded.

4.5.3 View Oldest Product

The View Oldest Product menu option, available from the Control menu, provides the capability to display the oldest product downloaded and stored in memory.  When this menu option is selected, the product displayed in the active window will be updated with the oldest version of the downloaded product.

To View the Oldest Product Version:

1. <Click> Control on the menu bar.

2. <Select> the View Oldest Product option.  The oldest downloaded product version is displayed in the active window.

NOTE:
This procedure assumes that a product has been loaded.

4.5.4 View Previous Product

The View Previous Product menu option, available from the Control menu, provides the capability to display the proceeding downloaded and stored version of the product.  When this menu option is selected, the product displayed in the active window will be updated with the prior version of the downloaded product.

To View the Previous Product Version:

1. <Click> Control on the menu bar.

2. <Select> the View Previous Product option.  The previous downloaded product version is displayed in the active window.

NOTE:
This procedure assumes that a product has been loaded.

4.5.5 View Next Product

The View Next Product menu option, available from the Control menu, provides the capability to display the next downloaded and stored version of the product.  When this menu option is selected, the product displayed in the active window will be updated with the next version of the downloaded product.

To View the Next Product Version:

1. <Click> Control on the menu bar.

2. <Select> the View Next Product option.  The next downloaded product version is displayed in the active window.

NOTE:
This procedure assumes that a product has been loaded.

4.5.6 View Latest Product

The View Latest Product menu option, available from the Control menu, provides the capability to display the most recent product downloaded and stored in memory.  When this menu option is selected, the product displayed in the active window will be updated with the newest version of the downloaded product.

To View the Latest Product:

1. <Click> Control on the menu bar.

2. <Select> the View Latest Product menu option.  The latest downloaded product version is displayed in the active window.

NOTE:
This procedure assumes that a product has been loaded.

4.5.7  XE "Automatic Update" Automatic Update

The Automatic Update menu option, available from the Control menu, provides the capability to automatically display the most recent downloaded version of a product.  When the new product version arrives, the displayed product is automatically updated.

By default, products being viewed are set to be updated automatically as indicated by the check mark to the left of the Automatic Update menu option.  When Automatic Update is not being used, the most recent version of a product may still be downloaded to the local disk, but the view of the product in a window will remain unchanged.  This capability can be toggled off or on by simply selecting Automatic Update from the Control menu.

To Automatically Update the Displayed Product:

1. <Click> Control on the menu bar.

2. <Select> the Automatic Update menu option.  The most recent version of the downloaded product is displayed.

NOTE:
This procedure assumes that a product has been loaded.

4.5.8  XE "Audible Notification" Audible Notification

The Audible Notification menu option, available from the Control menu, provides the capability to sound an audible beep when a displayed product updates to the latest available product.

This alarm can be toggled off or on by simply selecting Audible Notification from the Control menu.

To Audibly Notify of an Update to the Displayed Product:

1. <Click> Control on the menu bar.

2. <Select> the Audible Notification option.  The Audible Notification option is activated, as indicated by the check mark to the left of the Automatic Update menu option.

NOTE:
This procedure assumes that a product has been loaded.

4.6  XE "Animation:Menu" \r "D2HBAnimation97" 

 XE "Animation:Toolbar Section" \r "D2HBAnimation97" Animation

The Animation menu provides an interface to display an animated product when a series of sequential product times are available.  The number of sequential product times available is determined from the Download XE "Download"  tabbed page of the Properties dialog box.  An animation must have at least two versions of the SAME product to be run.

The Animation menu consists of the Load Product Times for Animation, Reverse Play, Step Backward, Stop Animation, Step Forward, Forward Play, Set Animation Speed, Set Pause after Animation Loop, Discard Frame, Flip Animation Loop, and Quit Animation options.

Although the Animation menu is available when a product is loaded, only the Load Product Times for Animation option is enabled until an animation has been loaded.

[image: image131.png]Load Product Times for Animation.

Beverse Play
Step Backnard
Stop Animation
Step Forward
Foward Play

Set Animaton Speed.
Set Pause after Arimation Loop.

Discard Frame
Flp Arimation Loop

Quit Animation





Figure 4‑64  Animation Menu

To Display the Animation Menu:

1. <Click> Animation on the menu bar.

NOTE:
This procedure assumes that a product has been loaded.

4.6.1 Load Product Times for Animation

The Load Product Times for Animation menu option, available from the Animation menu, displays the Product Times dialog box.  The Product Times dialog box provides the capability to select a series of product times to view in animation.  If only one product time is listed, display the Properties dialog box and increase the ‘Number of products to save on local disk’.  Then from the main menu select ‘Options->Request Latest Product’.  This will retrieve the additional products from the weather graphics server if they exist.  Although the maximum number of products you are able to load into the animation loop is 99, it is recommended that no more than 12 images be loaded into any one animation.  Too many animation loops may degrade performance depending on the processor speed and amount of memory installed on the computer.

Once an animation loop is successfully loaded, additional animation menu options become active and the Load Product Times for Animation menu option is disabled.  Since only one animation can be loaded at a time, the Load Product Times for Animation menu option stays disabled until the Quit Animation menu option is executed.
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Figure 4‑65  Product Times Dialog Box

Table 4‑47  Product Times Dialog Box Description

	Label
	Component
	Purpose

	Product Times
	List Box
	Displays a list of available products by time.

	Number Selected
	Display Box
	Displays the number of product times that have been selected for animation.

	Load
	Button
	Displays the sequence of selected products in an animation loop.

	Cancel
	Button
	Closes the dialog box without accepting any product times for animation loop.


To Load Product Times for an Animation:

1. <Click> Animation on the menu bar.

2. <Select> the Load Product Times for Animation menu option.

3. <Select> the desired Product Times from the list box.  Holding the Ctrl key while clicking on product times will allow selection of times that are not in sequence.  The product times are highlighted and the number selected is displayed in the Number Selected box.

4. <Click> the Load button to load the selected product times into an animation loop.  Each selected time is displayed as it is loaded into the animation loop.

NOTE:
This procedure assumes that a product has been loaded.

4.6.2 Reverse Play

The Reverse Play menu option, available from the Animation menu, reverses the order in which an animation loop is run.  In other words, when Reverse Play is selected, the product normally displayed first in the animation loop will become the last product displayed when the animation is run.  The Reverse Play menu option is only available for use when an animation is loaded.

To Reverse an Animation:

1. <Click> Animation on the menu bar.

2. <Select> the Reverse Play menu option.  The animation is displayed in reverse order.

NOTE:
This procedure assumes that an animation has been loaded.

4.6.3 Step Backward

The Step Backward menu option, available from the Animation menu, displays the product in the previous frame of the animation loop.  Repeated selection of the Step Backward option will step the loaded animation backward one frame at a time.  The Step Backward menu option is only available for use when an animation is loaded.

To Step Backward in an Animation:

1. <Click> Animation on the menu bar.

2. <Select> the Step Backward menu option.  The previous product in the animation is displayed.

NOTE:
This procedure assumes that an animation has been loaded.

4.6.4 Stop Animation

The Stop Animation menu option, available from the Animation menu, halts the current animation from forward or reverse play, but does not unload the animation.  The Stop Animation menu option is only available for use when an animation is loaded.

To Stop an Animation:

1. <Click> Animation on the menu bar.

2. <Select> the Stop Animation menu option.  The animation being played is halted.

NOTE:
This procedure assumes that an animation has been loaded.

4.6.5 Step Forward

The Step Forward menu option, available from the Animation menu, displays the product in the next frame of the animation.  Repeated selection of the Step Forward option will step the loaded animation forward one frame at a time.  The Step Forward menu option is only available for use when an animation is loaded.

To Step Forward in a Animation:

1. <Click> Animation on the menu bar.

2. <Select> the Step Forward menu option.  The next product in the animation is displayed.

NOTE:
This procedure assumes that an animation has been loaded.

4.6.6 Forward Play

The Forward Play menu option, available from the Animation menu, starts the animation.  The animation will play in the order in which the product times were originally selected.  The Forward Play menu option is only available for use when an animation is loaded.

To Play an Animation:

1. <Click> Animation on the menu bar.

2. <Select> the Forward Play menu option.  The loaded animation is started.

NOTE:
This procedure assumes that an animation has been loaded.

4.6.7 Set Animation Speed

The Set Animation Speed menu option, available from the Animation menu, displays the Animation Speed dialog box.  The Animation Speed dialog box provides the capability to vary the speed at which the frames of an animation are displayed.  The speed is set according to the number of frames that are displayed per second.  For example, if the Animation Speed is set at 6, then 6 product times will be displayed in a second.  The Set Animation Speed menu option is only available for use when an animation is loaded.
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Figure 4‑66  Animation Speed Dialog Box

Table 4‑48  Animation Speed Dialog Box Description

	Label
	Component
	Purpose

	Animation Speed 
	List Box
	Displays a list of available animation speeds (1-12 Frames per Second).

	OK
	Button
	Applies the selected speed and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.


To Set the Display Speed of an Animation:

1. <Click> Animation on the menu bar.

2. <Select> the Set Animation Speed menu option.  The Animation Speed dialog box is displayed.

3. <Select> the desired speed in frames per second from the list box.

4. <Click> the OK button to accept the selected speed.  The animation loop is displayed using the selected speed.

OR

5. <Click> the Cancel button to exit the function without changing the animation speed.

NOTE:
This procedure assumes that an animation has been loaded.

4.6.8 Set Pause after Animation Loop

The Set Pause after Animation Loop menu option, available from the Animation menu, displays the Pause after Animation Loop dialog box.  The Pause after Animation Loop dialog box provides the capability to adjust the length of pause between animation loops.  For example, if the pause is set at 4, then 4 seconds will pass between the end of an animation loop and the beginning of the next animation loop.  This pause will be in effect for both the forward and backward play modes, and can be set while an animation is playing or when stopped.  The Pause after Animation Loop menu option is only available for use when an animation is loaded.
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Figure 4‑67  Pause after Animation Loop Dialog Box

Table 4‑49  Pause after Animation Loop Dialog Box Description

	Label
	Component
	Purpose

	Pause after Animation Loop
	List Box
	Displays a list of available animation pause times (0-6 Seconds).

	OK
	Button
	Applies the selected pause length and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.


To Adjust the Pause After an Animation Loop:

1. <Click> Animation on the menu bar.

2. <Select> the Set Pause after Animation Loop menu option.  The Pause After Animation Loop (in seconds) dialog box is displayed.

3. <Select> the desired length of pause after an animation loop (in seconds) from the list box

4. <Click> the OK button to accept the new pause length and close the dialog box.

OR

5. <Click> the Cancel button to terminate this function without accepting any of the changes made and close the display.

NOTE:
This procedure assumes that an animation has been loaded.

4.6.9 Discard Frame

The Discard Frame menu option, available from the Animation menu, removes the currently displayed product time from the animation loop.  The animation must be reloaded for the discarded product time to again be included in the loop.  The Discard Frame menu option is only available for use when an animation is loaded.  A minimum of two products must remain in an animation.

To Discard a Frame from an Animation Loop:

1. <Click> Animation on the menu bar.

2. <Select> either the Step Forward or the Step Backward menu option to step through the product times of the animation loop.  Repeat steps 1 and 2 until the product to be removed from the animation is in the active display window.

3. <Click> Animation on the menu bar.

4. <Select> the Discard Frame menu option.  The displayed product time is removed from the animation loop.

5. <Click> the Forward Play or Reverse Play menu option on the Animation main menu or toolbar to view the animation loop without the discarded frame.

NOTE:
This procedure assumes that an animation has been loaded.

4.6.10 Flip Animation Loop

The Flip Animation Loop menu option, available from the Animation menu, provides the capability to repeatedly alternate between forward and reverse play.  The default value of the Flip Animation Loop option is disabled, as indicated by the absence of a check mark to the left of the option.  The Flip Animation Loop menu option is only available for use when an animation is loaded.

To Flip an Animation Loop:

1. <Click> Animation on the menu bar.

2. <Select> the Flip Animation Loop menu option.  The Flip Animation Loop menu option is enabled as indicated by the presence of the check mark next to the option.  The animation loop begins alternating between forward and reverse play.

NOTE:
This procedure assumes that an animation has been loaded.

4.6.11 Quit Animation

The Quit Animation menu option, available from the Animation menu, unloads the current animation loop.  When Quit Animation is executed, only the Load Product Times for Animation option is available from the Animation menu until a new animation has been loaded.

To Quit an Animation Loop:

1. <Click> Animation on the menu bar.

2. <Select> the Quit Animation menu option.  The current animation loop is unloaded.

NOTE:
This procedure assumes that an animation has been loaded.
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4.7  XE "Sequence:Define" 

 XE "Sequence:Load" Sequence

The Sequence menu provides an interface to display a sequence of Weather Graphic products.  Unlike the animation function, the sequence function can display different types of products within the same loop.  The Sequence menu consists of the Load Sequence, XE "Load Sequence" \r "D2HBLoad_Sequenc107"  Define Sequence, Reverse Play, Step Backward, Stop Sequence, Step Forward, Forward Play, Set Display Time, Discard Product, Add Product, Save, Save As, and Quit Sequence options.

Although the Sequence menu is available when no products are selected, only the Load Sequence and Define Sequence options are enabled until a sequence has been loaded.
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Figure 4‑68  Sequence Menu

To Display the Sequence Menu:

1. <Click> Sequence on the menu bar.

4.7.1 Load Sequence

The Load Sequence menu option, available from the Sequence menu, displays the Load Sequence dialog box.  The Load Sequence dialog box provides the capability to select an existing sequence for display.   Existing sequences are those that have been previously defined and saved.  Sequences can be loaded from either a user storage location or from a storage location on the local workstation.
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Figure 4‑69  Load Sequence XE "Sequence:Load"  Dialog Box

Table 4‑50  Load Sequence Dialog Box Description

	Label
	Component
	Purpose

	Storage Location
	Group Label
	These settings control which sequences are listed in the Sequence Name list box.

	User <User ID>
	Radio Button
	When selected, the Sequence Name list box will display the sequences that have been stored in the current user's profile.  If a user is not currently logged into WIND, this option will not be available for use.  If a user is logged into WIND, the User ID will be shown next to the radio button.

	Local Workstation
	Radio Button
	When selected, the Sequence Name list box will display the sequences that have been stored on the local workstation.

	Sequence Name
	List Box
	Displays a list of defined Sequence Names.

	OK
	Button
	Accepts and applies any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.


To Load a Sequence:

1. <Click> Sequence on the menu bar.

2. <Select> the Load Sequence menu option.

3. <Select> the desired Storage Location.
4. <Select> the desired Sequence Name.

5. <Click> the OK button to display the selected sequence.

OR

6. <Click> the Cancel button to terminate this function without loading the selected sequence.

4.7.2  XE "Sequence:Define" Define Sequence

The Define Sequence menu option, available from the Sequence menu, displays the Sequence Definition dialog box.  The Sequence Definition dialog box provides the capability to create, modify, and delete a sequence.  Sequences can be saved to either a user storage location or a storage location on the local workstation.
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Figure 4‑70  Sequence Definition Dialog Box

Table 4‑51  Sequence Definition Dialog Box Description

	Label
	Component
	Purpose

	Classes
	Scroll List
	Displays a list of product types available from the Weather Graphics database.

	Clipboards
	Scroll List
	Displays a list of products available within a selected Class.

	Add
	Button
	Adds the selected product (class and clipboard) to the Product Sequence list box.

	Remove
	Button
	Removes the selected product from the Product Sequence list box.

	Remove All
	Button
	Removes all of the products from the Product Sequence list box.

	Product Sequence
	List Box
	Displays a list of all products that have been selected to create a new sequence.  Additionally, it displays the products that are in an existing sequence, which are selected from the Sequence Name drop-down list box.

	Order Up
	Button
	Moves the product selected in the Product Sequence list box up in the display order.

	Order Down
	Button
	Moves the product selected in the Product Sequence list box down in the display order.

	Storage Location
	Group Label
	These settings control where the current sequence should be saved.  These settings also control which sequences will be displayed in the Sequence Name scroll list.  

	User <User ID>
	Radio Button
	Sets the current sequence definition storage location to the current user’s profile.  It also populates the Sequence Name Scroll List with all sequence definitions previously stored in the current user’s profile.  Sequence definitions saved to the current user’s profile will be available to the current user on any workstation.  This option will not be available if a user is not logged into WIND.  If a user is logged into WIND, the User ID will be shown next to the radio button.

	Local Workstation
	Radio Button
	Sets the current sequence definition storage location to the local workstation.  It also populates the Sequence Name Scroll List with all sequence definitions previously stored on the local workstation.  Sequence definitions saved to the local workstation will be available to any user using the current workstation.

	Sequence Name
	Text Box
	Allows the user to type a sequence name to be saved as a new sequence.

	Sequence Name
	Scroll List 
	Allows the user to select from a  list of available sequence names.  The selected sequence is highlighted and displayed in the text box.  

	Save
	Button
	Saves a new sequence by the name entered into the Sequence Name text box.

	Delete
	Button
	Deletes the sequence selected in the Sequence Name scroll list.

	Close
	Button
	Closes the dialog box.


To Define a New Sequence:

1. <Click> Sequence on the menu bar.

2. <Select> the Define Sequence menu option to display the Sequence Definition dialog box.

3. <Select> the desired Class from the Class scroll list.

4. <Select> the desired product from the Clipboard scroll list.

5. <Click> the Add button to add the selected product to the Product Sequence list box.  Repeat steps 3, 4, and 5 to add as many products as desired to the sequence.

6. <Click> the Remove button, after selecting any product not needed in the sequence, to remove the product from the Product Sequence list box.

7. <Click> the Up Arrow button, after selecting a product in the Product Sequence list box, to move the product forward in the display order of the sequence.  The order in which the products are listed in the Product Sequence list box represents the order in which the products will be displayed when the sequence is run.

8. <Click> the Down Arrow button, after selecting a product in the Product Sequence list box, to move the product backward in the display order of the sequence.  The order in which the products are listed in the Product Sequence list box represents the order in which the products will be displayed when the sequence is run.

9. <Select> the desired Storage Location.
10. Enter a name for the sequence in the Sequence Name text box.

11. <Click> the Save button to save the newly defined sequence.  A message is displayed indicating that the sequence definition file was saved successfully.

12. <Click> the OK button to acknowledge.

13. <Click> the Close button to close the Sequence Definition dialog box.

NOTE:
The Sequence XE "Sequence:Load" 

 XE "Sequence:Define"  scroll list can also be used to retrieve a previously defined Product Sequence for modification.

To Delete a Sequence:

1. <Click> Sequence on the menu bar.

2. <Select> the Define Sequence menu option to display the Sequence Definition dialog box.

3. <Select> the Storage Location which contains the sequence that is to be deleted.

4. <Select> a previously defined sequence from the Sequence Name scroll list.  The selected sequence name is displayed and the products contained in the sequence are listed in the Product Sequence list box.

5. <Click> the Delete button to delete the Product Sequence.  A confirmation dialog box is displayed.

6. <Click> the Yes button to confirm the delete function and remove the product sequence.

OR

7. <Click> the No button to quit the delete function without deleting the product sequence.

8. <Click> the Close button to close the Sequence Definition dialog box.

4.7.3 Reverse Play

The Reverse Play menu option, available from the Sequence menu, reverses the order in which a sequence is run.  In other words, when Reverse Play is selected, the product normally displayed first in the defined sequence will become the last product displayed when the sequence is run.  The Reverse Play menu option is only available for use when a sequence is loaded.

To Reverse a Sequence:

1. <Click> Sequence on the menu bar.

2. <Select> the Reverse Play menu option.  The sequence is displayed in reverse order.

NOTE:
This procedure assumes that a sequence has been loaded.

4.7.4 Step Backward

The Step Backward menu option, available from the Sequence menu, displays the product in the previous frame of the sequence.  Repeated selection of the Step Backward option will step the loaded product sequence backward one frame at a time.  The Step Backward menu option is only available for use when a sequence is loaded.

To Step Backward in a Sequence: XE "Sequence:Step Backward/Forward" 
1. <Click> Sequence on the menu bar.

2. <Select> the Step Backward menu option.  The previous product in the sequence is displayed.

NOTE:
This procedure assumes that a sequence has been loaded.

4.7.5 Stop Sequence

The Stop Sequence menu option, available from the Sequence menu, halts the current sequence from forward or reverse play, but does not unload the sequence.  The Stop Sequence menu option is only available for use when a sequence is in forward or reverse play.

To Stop a Sequence:

1. <Click> Sequence on the menu bar.

2. <Select> the Stop Sequence menu option.  The sequence being played is halted.

NOTE:
This procedure assumes that a sequence has been loaded.

4.7.6 Step Forward

The Step Forward menu option, available from the Sequence menu, displays the product in the next frame of the sequence.  Repeated selection of the Step Forward option will step the loaded product sequence forward one frame at a time.  The Step Forward menu option is only available for use when a sequence is loaded.

To Step Forward in a Sequence:

1. <Click> Sequence on the menu bar.

2. <Select> the Step Forward menu option.  The next product in the sequence is displayed.

NOTE:
This procedure assumes that a sequence has been loaded.

4.7.7 Forward Play

The Forward Play menu option, available from the Sequence menu, starts the sequence.  The sequence will play in the order in which it was originally defined.  The Forward Play menu option is only available for use when a sequence is loaded.

To Play a Sequence:

1. <Click> Sequence on the menu bar.

2. <Select> the Forward Play menu option.  The loaded sequence is started.

NOTE:
This procedure assumes that a sequence has been loaded.

4.7.8 Set Display Time

The Set Display Time menu option, available from the Sequence XE "Sequence:Set Display Time"  menu, displays the Sequence Rate dialog box.  The Sequence Rate dialog box provides the capability to adjust the rate at which the frames of a sequence are displayed.  The rate is set according to the number of seconds an individual product within the sequence is displayed.  For example, if the Sequence Rate is set at 5, each product is displayed for 5 seconds before continuing to the next frame in the sequence.  The Set Display Time menu option is only available for use when a sequence is loaded.
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Figure 4‑71  Sequence Rate Dialog Box

Table 4‑52  Sequence Rate Dialog Box Description

	Label
	Component
	Purpose

	Enter Sequence Rate as Seconds per Product
	Text Box
	Displays the current Sequence Rate and allows a new Sequence Rate to be entered.  The rate is the number of seconds an individual product within the sequence is displayed

	OK
	Button
	Accepts and applies any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.


To Modify the Product Display Time for a Sequence:

1. <Click> Sequence on the menu bar.

2. <Select> the Set Display Time menu option.  The Sequence Rate dialog box is displayed.

3. Enter the desired sequence display rate (in seconds) in the Enter Sequence Rate as Seconds per Product text box.

4. <Click> the OK button to accept the new display rate and close the dialog box.

OR

5. <Click> the Cancel button to terminate this function without accepting any of the changes made and close the display.

NOTE:
This procedure assumes that a sequence has been loaded.

4.7.9 Discard Product

The Discard Product menu option, available from the Sequence XE "Sequence:Discard Product"  menu, removes the currently displayed product from the loaded sequence.  It does not permanently remove the product from the sequence, only from the current display.  The Discard Product menu option is only available for use when a sequence is loaded.

To permanently remove a product from a sequence the sequence must either be saved after the product has been discarded, or the sequence must be redefined using the Define Sequence menu option.  A minimum of two products must remain in a sequence.

To Discard a Product from a Sequence:

1. <Click> Sequence on the menu bar.

2. <Select> either the Step Forward or the Step Backward menu option to step through the products of the sequence.  Repeat steps 1 and 2 until the product to be deleted is in the active display window.

3. <Click> Sequence on the menu bar.

4. <Select> the Discard Frame menu option.  The displayed product is removed from the sequence.

NOTE:
This procedure does not permanently remove the product from the sequence, only from the current display.

4.7.10 Add Product

The Add Product menu option, available from the Sequence menu, displays the Current Products dialog box to allow a new product to be selected and displayed in the loaded sequence.  It does not permanently add the product to the sequence, only to the current display.  The Add Product menu option is only available for use when a sequence is loaded.

To permanently add a product to a sequence the sequence must either be saved after the product has been added, or the sequence must be redefined using the Define Sequence menu option.

To Add a Product to a Sequence:

1. <Click> Sequence on the menu bar.

2. <Select> either the Step Forward or the Step Backward menu option to step through the products of the sequence.  Repeat steps 1 and 2 until reaching the frame where the new product is to be added.  The new product will be added to the sequence prior to the currently displayed product.

3. <Click> Sequence on the menu bar.

4. <Select> the Add Product menu option.  The Current Products dialog box is displayed.

5. <Select> the desired Class and Clipboard from the list boxes.

6. <Click> the Display button to display the selected product.  The product is added to the sequence prior to the currently displayed product.

NOTE:
This procedure does not permanently add the product to the sequence, only to the current display.

4.7.11 Save

The Save menu option, available from the Sequence XE "Sequence:Save"  menu, permanently saves the active sequence under the current sequence name.  This command is used to save a predefined sequence that has been modified using the Add Product or Discard Product menu options.  The Save menu option is only available for use when a sequence is loaded.

To Save Changes to a Predefined Product Sequence:

1. <Click> Sequence on the menu bar.

2. <Click> the Save menu option to save the sequence using its current name.

NOTE:
This procedure assumes that a sequence has been loaded.

4.7.12 Save As…

The Save As menu option, available from the Sequence menu, displays the Save As Sequence dialog box.  The Save As Sequence dialog box provides the capability to permanently save the active sequence under a new sequence name.  This command is used to save a predefined sequence that has been modified using the Add Product or Discard Product menu options.  The Save As menu option is only available for use when a sequence is loaded.  Sequences can be saved to either a user storage location or a storage location on the local workstation.
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Figure 4‑72  Save As Sequence Dialog Box

Table 4‑53  Save As Sequence XE "Sequence:Save"  Dialog Box Description

	Label
	Component
	Purpose

	Enter Sequence Name
	Text Box
	Displays the current Sequence name and allows a new Sequence name to be entered.

	Storage Location
	Group Label
	Used to select where the sequence should be saved.

	User <User ID>
	Radio Button
	Sets the current sequence definition to be saved to the current user’s profile.  Sequence definitions saved to the current user’s profile will be available to the current user on any workstation.  This option will not be available if a user is not logged into WIND.  If a user is logged into WIND, the User ID will be shown next to the radio button.

	Local Workstation
	Radio Button
	Sets the current sequence definition to be saved to the local workstation.  Sequence definitions saved to the local workstation will be available to any user using the current workstation.

	OK
	Button
	Accepts and applies any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.


To Save a Predefined Sequence Using a New Name:

1. <Click> Sequence on the menu bar.

2. <Click> the Save As menu option.  The Save As Sequence dialog box is displayed.

3. Enter the new sequence name in the text box.

4. <Select> the desired Storage Location.
5. <Click> the OK button to perform the Save As command.  The modified product sequence is redefined using a new product name.

OR

6. <Click> the Cancel button to terminate this function without saving the changes to the product sequence

NOTE:
This procedure assumes that a sequence has been loaded.

4.7.13 Quit Sequence

The Quit Sequence menu option, available from the Sequence menu, unloads the current sequence.  Once Quit Sequence is executed, only the Load Sequence XE "Load Sequence"  and Define Sequence options are available from the Sequence menu until a new sequence has been loaded.

To Quit the Sequence:

1. <Click> Sequence on the menu bar.

2. <Select> the Quit Sequence menu option.  The current sequence is unloaded.

NOTE:
This procedure assumes that a sequence has been loaded.

4.7.14  XE "Zoom" 

 XE "Sequence:Virtual Zoom" Virtual Zoom Sequence

A Virtual Zoom Sequence is a predefined sequence that is loaded automatically when the user opens any one of the images defined in the virtual zoom sequence.  Unlike a normal sequence, the user will not be able to alter or manipulate a virtual zoom sequence using the predefined sequence menu options.  Its purpose is to allow the user to go from a low to a high resolution image by using the left mouse button.  
Table 4‑54  Predefined Virtual Zoom Sequences

	TYPE
	CLASS NAME
	8KM CLIPBOARD NAME
	4KM CLIPBOARD NAME
	2KM CLIPBOARD NAME
	SITE CLIPBOARD NAME

	Base Reflectivity
	RADAR_MOSAICS
	BREF_USA
	BREF_4KM
	BREF_2KM
	Closest NEXRAD_SITE Image for BASE_TILT1

	Composite Reflectivity
	RADAR_MOSAICS
	CREF_USA
	CREF_4KM
	N/A
	Closest NEXRAD_SITE Image for COMPOSITE

	Echo Tops
	RADAR_MOSAICS
	TOPS_USA
	TOPS_4KM
	N/A
	Closest NEXRAD_SITE Image for ECHO_TOPS

	Winter Storm Mosaic
	RADAR_MOSAICS
	WINTER_USA
	WINTER_4KM
	WINTER_2KM
	N/A

	Alaska Base Reflectivity
	RADAR_MOSAICS
	N/A
	AK_BREF_4KM
	AK_BREF_2KM
	Closest NEXRAD_SITE Image for BASE_TILT1

	Alaska Winter Storm Mosaic
	RADAR_MOSAICS
	N/A
	AK_WINTER_4KM
	AK_WINTER_2KM
	N/A

	Hawaii Base Reflectivity
	RADAR_MOSAICS
	N/A
	HI_BREF_4KM
	HI_BREF_2KM
	Closest NEXRAD_SITE Image for BASE_TILT1


When the user positions the mouse over an area of interest and clicks the left mouse button, the next image in the virtual zoom sequence will display and center over that area.  When the user reaches the last image in the sequence and clicks the left mouse button, the closest site image will load and display (if applicable).  The sequence will cycle back around from the site image to the first image in the sequence on the next left mouse button click.  Any overlays XE "Overlay:Background"  placed on one image will not be carried over to the other images in the virtual zoom sequence.  A toolbar XE "Toolbar"  will display the closest radar site to the mouse cursor as the mouse moves over the image.

THIS PAGE INTENTIONALLY LEFT BLANK
4.8 View

The View menu provides an interface for displaying the toolbar XE "Toolbar" \r "D2HBToolbar117"  and status bar in the Weather Graphics Window, and legend bars and thumbnail title bars in active product windows.  Additionally, it provides an interface for displaying a current product in normal view, sized to fit the active window, or zoomed to four different size options.

The View menu initially consists of the Toolbar and Status Bar XE "Status Bar"  menu options.  After a product has been loaded, additional options are added and the View menu expands to include: Legend Bars, Thumbnail Title Bars, Plot Product Bar, Storm Attribute Overlay, and viewing options of Normal, Size To Fit Window, XE "Size To Fit Window"  or Zoom. XE "Zoom" 
When a product is first loaded, the following View menu items are selected by default:  Tool Bar, XE "Toolbar"  Status Bar, Thumbnail Title Bars, and Normal.
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Figure 4‑73  View Menu
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Figure 4‑74  View Menu (with a product open)

To Display the View Menu:

1. <Click> View on the menu bar.

4.8.1 Toolbar

The Toolbar menu option, available from the View menu, displays or hides the toolbar.  The toolbar is a panel of buttons designed to provide quick, easy access to specific menu commands or options.  The toolbar contains sets of buttons associated with five main (pull-down) menus, and is located directly under the menu bar.  The default value of the Toolbar option is enabled, as indicated by the check mark to the left of the Toolbar menu option.
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Figure 4‑75  WIND Menu Bar and Toolbar

To Display the Toolbar:

1. <Click> View on the menu bar.

2. <Select> the Toolbar menu option.  A check mark to the left of the Toolbar menu item is displayed to indicate the toolbar menu option is in effect.

4.8.1.1  XE "File Toolbar Section" File Toolbar Section

The File section of the toolbar is a subset of the File menu options and can be used to open or print a product.  This section of the toolbar includes:  Open Current Product, XE "Current Product"  Save, and Print.
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Figure 4‑76 File Toolbar Section

Table 4‑55  File Toolbar Section Description

	Label
	Component
	Purpose

	Open Current Product 
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	Button
	Displays the Current Products dialog box.

	Save
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	Button
	Disabled and unavailable for use.

	Print
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	Button
	Displays the Print dialog box.


4.8.1.2  XE "Control Toolbar Section" \r "D2HBControl_Tool119" Control Toolbar Section

The Control section of the toolbar is a subset of the Control menu options and can be used to display active products by time.  This section of the toolbar includes:  Select Product Time, View Oldest Product, View Previous Product, View Next Product, and View Latest Product.
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Figure 4‑77  Control Toolbar Section

Table 4‑56  Control Toolbar Section Description

	Label
	Component
	Purpose

	Select Product Time
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	Button
	Displays the Product Times dialog box.

	View Oldest Product
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	Button
	Displays the oldest pro
duct downloaded and stored in memory.

	View Previous Product
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	Button
	Displays the preceding downloaded and stored version of the product.

	View Next Product
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	Button
	Displays the next downloaded and stored version of the product.

	View Latest Product
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	Button
	Displays the most recent product downloaded and stored in memory.


4.8.1.3  XE "Animation:Menu" \r "D2HBAnimation119" 

 XE "Animation:Toolbar Section" \r "D2HBAnimation119" Animation Toolbar Section

The Animation section of the toolbar is a subset of the Animation menu options and can be used to direct all available movements for an animation.  This section of the toolbar includes:  Load Product Times for Animation, Reverse Play, Step Backward, Stop Animation, Step Forward, Forward Play, Set Animation Speed, Set Pause after Animation Loop, and Quit Animation.
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Figure 4‑78  Animation Toolbar Section

Table 4‑57  Animation Toolbar Section Description

	Label
	Component
	Purpose

	Load Product Times for Animation 
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	Button
	Displays the Product Times dialog box.

	Reverse Play
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	Button
	Starts the animation in reverse play.

	Step Backward
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	Button
	Displays the previous frame of the animation.

	Stop Animation
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	Button
	Halts the animation.

	Step Forward
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	Button
	Displays the next frame of the animation.

	Forward Play
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	Button
	Starts the animation in forward play.

	Set Animation Speed

[image: image160.png]



	Drop-down List Box
	Changes the rate at which the frames of an animation are displayed.

	Set Pause after Animation Loop
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	Drop-down List Box
	Changes the length of pause between animation loops.

	Quit Animation 
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	Button
	Unloads the current animation.


4.8.1.4  XE "Sequence:Toolbar" Sequence Toolbar Section

The Sequence section of the toolbar is a subset of the Sequence menu options and can be used to direct all available movements for a sequence.  This section of the toolbar includes:  Load Sequence, XE "Load Sequence"  Reverse Play, Step Backward, Stop Sequence, Step Forward, Forward Play, Set Sequence Rate, and Quit Sequence.
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Figure 4‑79  Sequence XE "Sequence:Toolbar"  Toolbar Section

Table 4‑58  Sequence Toolbar Section Description

	Label
	Component
	Purpose

	Load Sequence 
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	Button
	Displays the Load Sequence dialog box.

	Reverse Play
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	Button
	Starts the sequence in reverse play.

	Step Backward
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	Button
	Displays the previous frame of the sequence.

	Stop Sequence
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	Button
	Halts the sequence.

	Step Forward
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	Button
	Displays the next frame of the sequence.

	Forward Play
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	Button
	Starts the sequence in forward play.

	Set Sequence Rate
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	Button
	Sets the length of time for which each frame in a sequence is displayed.

	Quit Sequence
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	Button
	Unloads the current sequence.


4.8.1.5 User State Toolbar Section

The User State section of the toolbar is a subset of the Options menu options and can be used to restore the saved  WIND user state of the user currently logged into WINGS.  This section of the toolbar includes:  Restore User Application State.
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Figure 4‑80  User State Section

Table 4‑59  User State Section Description

	Label 
	Component
	Purpose

	Restore User Application State
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	Button
	Restores the saved WIND user state of the user currently logged into WINGS.


4.8.1.6  XE "Help Toolbar Section" Help Toolbar Section

The Help section of the toolbar is a subset of the Help menu options and can be used to open the help system.  This section of the toolbar includes:  Help Topics. XE "Help Topics" 
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Figure 4‑81  Help Toolbar Section

Table 4‑60  Help Toolbar Section Description

	Label
	Component
	Purpose

	Help Topics
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	Button
	Starts the Help system.


4.8.2  XE "Status Bar" Status Bar

The Status Bar menu option, available from the View menu, displays or hides the status bar.  The status bar is an area located at the bottom of the Weather Graphics Window that displays current information about the active session.  The status bar provides descriptive messages about a selected menu, toolbar buttons, key commands, or latitude and longitude coordinates.  The default value of the Status Bar menu option is enabled, as indicated by the check mark to the left of the Status Bar menu option.

To Display the Status Bar:

1. <Click> View on the menu bar.

2. <Select> the Status Bar menu option.  The check mark to the left of the Status Bar menu item is displayed and the Status Bar is displayed at the bottom of the Weather Graphics Window.
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Figure 4‑82  WIND Status Bar

4.8.3  XE "Legend Bar" Legend Bars
The Legend Bars menu option, available from the View menu, displays or hides legend bars.  A legend bar is an area located at the bottom of each product window.  There are two different types of legends.  The first is a graphical legend, which describes the purpose of different colors or symbols on the product.  If a graphical legend is not available for the product, a text based legend which displays current information such as product class, clipboard, date, and time, will be shown.  The default value of the Legend Bars menu option is disabled, as indicated by the lack of a check mark to the left of the Legend Bars menu option.
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Figure 4‑83  Product Window With Text Legend Bar Displayed
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Figure 4‑84  Product Window With Graphical Legend Bar Displayed
To Display the Legend Bar:

1. <Click> View on the menu bar.

2. <Select> the Legend Bars menu option.  The check mark to the left of the Legend Bar menu item is displayed.

NOTE:
This procedure assumes that a product has been loaded.

4.8.4  XE "Thumbnail Title Bar" Thumbnail Title Bar

The Thumbnail Title Bars menu option, available from the View menu, displays or hides thumbnail title bars.  A thumbnail title bar is an area located at the bottom of each minimized product window that displays current information about the product contained in the thumbnail window such as product class, clipboard, date, and time.  The default value of the Thumbnail Title Bars menu option is enabled, as indicated by the check mark to the left of the Thumbnail Title Bars menu option.
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Figure 4‑85  Thumbnail With Title Bar
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Figure 4‑86  Thumbnail Without Title Bar

To Display the Thumbnail Title Bars:

1. <Click> View on the menu bar.

2. <Select> the Thumbnail Title Bars menu option.  The check mark to the left of the Thumbnail Title Bar menu item is displayed.

3. <Click> the Minimize button to display a product in Thumbnail view.  The product appears as a Thumbnail view with the Thumbnail Title Bar displayed.

NOTE:
This procedure assumes that a product has been loaded.

4.8.5 Plot Product Bar 

The plot product bar may be used as a legend and to quickly toggle different plot types ON and OFF.  Each plot category (AIRMET, SIGMET, Weather, Pilot Report and Temporary Flight Restrictions) has a toolbar XE "Toolbar" \r "D2HBToolbar125"  associated with it.  Each toolbar may be made visible/hidden from the main menu’s View->Plot Product Bar sub menu or using the right mouse button and selecting a toolbar from the Plot Product Toolbars sub menu.  The user may quickly toggle ON/OFF individual plot types of each category.  Each plot type (except for Pilot Report) button contains a line to indicate the current drawing line color and thickness.  The Pilot Report toolbar buttons show the color the category will be drawn in.  The Pilot Report toolbar also contains three altitude filtering buttons as well as a button to display the Pilot Reports XE "Reports"  with Unknown Locations.  The Temporary Flight Restrictions toolbar also contains a button to display the Temporary Flight Restrictions with Unknown Locations.  Each toolbar contains a composite button which toggles all plot types ON or OFF.  Each toolbar contains a date and time in GMT which indicates the last time files were downloaded from the Weather Graphics Server. XE "Weather Graphics Server"   The Pilot Report toolbar also contains the timespan for which pilot reports are being displayed.  This can be configured in the Pilot Report Product Property tabbed page.
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Figure 4‑87  Plot Product Toolbars 
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Figure 4‑88  Plot Product Bar menu
To Display the Plot Product Bar(s): 

1. <Click> View on the menu bar.

2. <Select> the Plot Product Bar menu option.

3. <Select> the menu item for the toolbar you wish to display.  The check mark to the left of each toolbar indicates the toolbar is currently displayed.

NOTE:
This procedure assumes that a product has been loaded. 

4.8.6  XE "Overlay:Storm" Storm Attribute Overlay

The Storm Attribute Overlay overlays storm cells on the current image, as well as displaying the storm attribute table below the image.  The menu item will be checked when the overlay is on for the current product, and not checked when the overlay is off for the current product.

To Display the Storm Attribute Overlay

1. <Click> View on the menu bar.

2. <Select> the Storm Attribute Overlay menu option.  The check mark to the left of the Storm Attribute Overlay menu item is displayed.

NOTE:  This procedure assumes that a product has been loaded.

4.8.6.1 Storm Attribute Table

When the storm attribute overlay is on for the current product, the storm attribute table will be displayed below the image if enabled.  (See Product Properties XE "Product Properties"  for more information about enabling the storm attribute table).  The check boxes next to each storm can be used to quickly hide storms currently displayed on the overlay.  Once a storm is hidden, it will remain hidden until the box is checked again.  This is useful to de-clutter the screen when there are several storms in the same area and the user is only interested in a few of them.  The table displays each entry in the color of the most severe weather phenomena displayed by the storm (TVS, MESO, Severe Hail, or Hail).  If the storm does not display any of these weather phenomena, it is displayed in white.  The last update time of the storm attribute data, as well as the station being displayed, is shown above the storm attribute table, even if no storm attribute data is available.
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Figure 4‑89  Storm Attribute Table

4.8.7 Normal 

The Normal menu option, available from the View menu, displays the current active product in a typical view.  Selecting this view will return a displayed product from the Size to Fit Window view.  The default value of the Normal menu option is enabled, as indicated by the check mark to the left of the Normal menu option.

To Display the Product in Normal View:

1. <Click> View on the menu bar.

2. <Select> the Normal menu option.  The check mark to the left of the Normal menu item is displayed.

NOTE:
This procedure assumes that a product has been loaded.

4.8.8  XE "Size To Fit Window" Size To Fit Window 

The Size to Fit Window menu option, available from the View menu, displays the current active product according to the size of the window.  The default value of the Size to Fit Window option is disabled, as indicated by the lack of a check mark to the left of the Size to Fit Window menu option.

To Display the Product in a Size to Fit Window:

1. <Click> View on the menu bar.

2. <Select> the Size To Fit Window menu option.  The displayed product is adjusted to fit the window size.

NOTE:
This procedure assumes that a product has been loaded.

4.8.9  XE "Zoom" \r "D2HBZoom127" Zoom 

The Zoom menu option, available from the View menu, displays a cascade menu containing four zoom factors:  2x, 4x, 8x, and 16x.  Selecting one of these zoom factors opens a new window to display a view of the currently active product according to the zoom factor selected.
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Figure 4‑90  Zoom Cascade XE "Cascade"  Menu Options

The new zoom window can be sized using the edge of the zoom window.  The mouse pointer changes to a two-directional arrow over the edge of the zoom window to indicate the sizing functionality is active.  Resizing the zoom window does not affect the zoom factor, it simply increases or decreases the portion of the product displayed.  Additionally, the area of the product displayed in the new zoom window can be reselected or panned.  Closing the Zoom window returns the display to Normal view.
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Figure 4‑91  Display Area Zoomed to 2x

To Zoom a Current Product: XE "Current Product" 
1. <Click> View on the menu bar.

2. <Select> the Zoom menu option.

3. <Select> the desired zoom factor from the cascade menu.  A view of the product is displayed in a new zoom window.

4. <Click> anywhere on the product in the original window to display that area in the zoom window.  A rectangle is drawn on the product to indicate the area being displayed in the zoom window.

5. <Click> the Close button on the top right of the zoom window to close the zoom window and return to the active product window.

NOTE:
This procedure assumes that a product has been loaded and is being viewed in Normal view.

To Size a Zoom Window:

1. <Click> View on the menu bar.

2. <Select> the Zoom menu option.

3. <Select> the desired zoom factor from the cascade menu.  A view of the product is displayed in a new zoom window.

4. Position the mouse pointer at the edge of a zoom window.  The pointer changes to a two-directional arrow to indicate the sizing functionality is active.

5. <Click and Drag> the mouse, while keeping the left mouse button depressed, until the window reaches the desired size.  This does not affect the zoom factor, it simply increases or decreases the portion of the product displayed.

6. <Click> the Close button on the top right of the zoom window to close the zoom window and return to the active product window.

NOTE:
This procedure assumes that a product has been loaded and is being viewed in Normal view.

To Pan the Area in the Zoom Window:

1. <Click> View on the menu bar.

2. <Select> the Zoom menu option.

3. <Select> the desired Zoom Factor from the cascade menu options.  A view of the product is displayed in a new zoom window.

4. <Click and Hold> anywhere within the original product window.  A rectangle is drawn on the product to indicate the area being displayed in the zoom window.

5. <Drag> the mouse, while keeping the left mouse button depressed, over the product in the original window.  The respective areas are displayed in the zoom window.

6. <Click> the Close button on the top right of the zoom window to close the zoom window and return to the active product window.

NOTE:
This procedure assumes that a product has been loaded and is being viewed in Normal view.

4.9 Options

The Options menu provides an interface for saving the window layout and configuration of displayed products.  Additionally, it provides an interface for changing application properties.

The Options menu consists of the Restore User State, XE "Restore User State"  Save User State Now, Restore Default State, XE "Restore Default State" \r "D2HBRestore_Defa134"  Save State As Default, Application Properties, XE "Application Properties" \r "D2HBApplication_131"  and Save IFR/VFR XE "IFR/VFR"  Overlays menu options.
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Figure 4‑92  Options Menu

To Display the Options Menu:

1. <Click> Options on the menu bar.

4.9.1 Restore User State

The Restore User State menu option, available from the Options menu, will restore the user preferences, which were previously saved with the Save User State Now option.  If no user state file exists, then the local default state will be used.

To Restore User States

1.
<Click> the Options menu.

2.
<Select> the Restore User State menu option.

4.9.2 Save User State Now

The Save User State Now menu option, available from the Options menu, saves the current product configuration.  This is the configuration that will be re-displayed upon restoring the user state.  

To Save the Product Configuration at Any Time:

1. <Click> the Options menu.

2. <Select> the Save User State Now menu option.  A dialog box will appear to confirm that the user state will be saved.  

3. <Click> the Yes button.  The displayed configuration is saved immediately.  


OR

4. <Click> the No button to cancel the request.

4.9.3 Restore Default State

The Restore Default State menu option, available from the Options menu, restores the product configuration to the default state.  The default product configuration can be displayed at any time without exiting the application by using the Restore Default State command.

To Restore the Product Configuration to the Default State:

1. <Click> Options on the menu bar.

2. <Select> the Restore Default State menu option.  The product configuration of the windows is restored to its default state.

4.9.4 Save State As Default

The Save State As Default menu option, available from the Options menu, saves the current product configuration as a new default configuration.  This will now be the default product configuration used for the Restore Default State command.

To Save a New Default Configuration:

1. <Click> Options on the menu bar.

2. <Select> the Save State As Default menu option.  A dialog box will appear to confirm the Save State as Default request.  

3. <Click> the Yes button.  The displayed product configuration is saved immediately.  

OR

4. <Click> the No button to cancel the request.

4.9.5 Application Properties

The Application Properties menu option, available from the Options menu, displays the Application Properties dialog box.  The Application Properties dialog box provides the capability to adjust the number and arrangement of thumbnails displayed, to adjust the tooltip radius, and to define removal time for old products.

The dialog box consists of the Display and Scrubber XE "Scrubber"  tabbed pages.

4.9.6 Display

The Display tabbed page of the Application Properties dialog box provides the options to adjust number and arrangement of displayed thumbnails.  The number of thumbnails displayed can be changed for both rows (horizontal) and columns (vertical). The tooltip radius, which determines the area around the mouse cursor that will be searched for potential tooltips, can also be set on this tabbed page.
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Figure 4‑93  Display Tabbed Page

Table 4‑61  Display Tabbed Page Description

	Label
	Component
	Purpose

	Display 
	Tab
	Displays the Display tabbed page.

	Number of horizontal thumbnails
	Text Box
	Allows the user to enter the number of thumbnails to be displayed horizontally.  The numerical value entered must be 1-20.

	Number of vertical thumbnails
	Text Box
	Allows the user to enter the number of thumbnails to be displayed vertically.  The numerical value entered must be 1-20.

	Tooltip radius
	Text Box
	Allows the user to set the tooltip radius in pixels.  The numerical value entered must be 1-15.

	OK
	Button
	Accepts any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.

	Apply
	Button
	Accepts any changes without closing the dialog box.


To Modify the Thumbnail Display Properties:

1. <Click> Options on the menu bar.

2. <Select> the Application Properties menu option to display the Application Properties dialog box.

3. <Click> the Display tab to display the Display tabbed page.

4. <Click> in the desired text box to change the number of thumbnails displayed horizontally or vertically.  The number entered must be 1-20.

5. <Click> the OK button to complete the function and close the dialog box.

OR

6. <Click> the Cancel button to terminate this function without accepting any of the changes made and close the dialog box.

To Modify the Tooltip Radius:

1. <Click> Options on the menu bar.

2. <Select> the Application Properties menu option to display the Application Properties dialog box.

3. <Click> the Display tab to view the Display tabbed page.

4. <Click> in the Tooltip radius text box to change the search radius for tooltips.  The number entered must be 1-15.

5. <Click> the OK button to complete the function and close the dialog box.

OR

6. <Click> the Cancel button to terminate this function without accepting any of the changes made and close the dialog box.

4.9.7  XE "Scrubber" Scrubber

The Scrubber tabbed page of the Application Properties dialog box provides the options to define the time period when a product is considered old and at what time intervals old products will be removed from the disk.  Additionally, it provides the ability to set time intervals for visual alarms when displayed products have become old.  These alarms appear as the words "OLD IMAGE" printed across the top of the product window.
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Figure 4‑94  Scrubber Tabbed Page

Table 4‑62  Scrubber Tabbed Page Description

	Label
	Component
	Purpose

	Scrubber 
	Tab
	Displays the Scrubber tabbed page.

	Disk Scrubber On
	Check Box
	Allows the user to set the scrubber functionality On or Off.  When the box is checked, the scrubber function is activated. 

	Scrub Maps
	Check Box
	Allows the user to select whether or not the "Maps" class will be scrubbed.  This option should remain in the "Off" state.

	Start Every:

(Hours:Minutes)
	Text Boxes
	Allows the user to enter the time intervals for the system to search and remove old products from the disk.  The disk scrubber must be activated to set the time.

	Visual Alarm On
	Check Box
	Allows the user to set the visual alarm functionality On or Off.  When the box is checked, the visual alarm function is activated.

	Start Every:

(Hours:Minutes)
	Text Boxes
	Allows the user to enter the time intervals for checking displayed products for an OLD IMAGE.  The user will be notified by the words "OLD IMAGE" printed across the top of the product window.

	Default time until Product is Considered Old

(Hours:Minutes)
	Text Boxes
	Allows the user to enter the default time interval for marking a product on disk as old.  This is set the first time the product is received.  Changing this value will not change the values for existing products on disk.  To change those values, see the ‘Properties’ dialog section.  If the product is manually deleted using the ‘Current Products’ dialog, the time interval will be reset to the default the next time the product is received.

	OK
	Button
	Accepts any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.

	Apply
	Button
	Accepts any changes without closing the dialog box.


To Modify the Scrubber, Visual Alarm, or Dated Product Properties: XE "Product Properties" 
1. <Click> Options on the menu bar.

2. <Select> the Application Properties menu option to display the Application Properties dialog box.

3. <Click> the Scrubber tab to display the Scrubber tabbed page.

4. <Click> in the associated check box to activate the desired functionality.  A check mark appears when the functionality is active.

5. <Click> in the desired text box to change the appropriate hours and minutes.

6. <Click> the OK button to complete the function and close the dialog box.

OR

7. <Click> the Cancel button to terminate this function without accepting any of the changes made and close the dialog box.

4.9.8  XE "Overlay:IFR/VFR" 

 XE "IFR/VFR" \r "D2HBIFR_VFR135" Save IFR/VFR Overlays

The Save IFR/VFR Overlays menu option, available from the Options menu, displays a cascade menu containing the IFR and VFR menu options.  These options provide the capability to modify the overlay settings reserved for IFR and VFR overlays.  In order to access these overlay settings, the user must select the IFR or VFR property type from the Stored Overlay Selections tabbed page (Current Product XE "Current Product"  Dialog box/Properties button) before opening a current product.
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Figure 4‑95  Save IFR/VFR Overlays Menu Options

4.9.9  XE "Overlay:IFR/VFR" IFR Overlays

The IFR cascade menu option, available from Save IFR/VFR Overlays menu option of the Options menu, displays the Save IFR Overlays dialog box.  The Save IFR Overlays dialog box provides the capability to setup or change graphic overlays.

The dialog box consists of the Geophysical, XE "Geophysical" \r "D2HBGeophysical138"  Boundaries, XE "Boundaries" \r "D2HBBoundaries136"  Sites, Aero XE "Aero" \r "D2HBAero136"  (Aeronautical), and Transportation XE "Transportation" \r "D2HBTransportati139"  tabbed pages.
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Figure 4‑96  Save IFR Overlays Dialog Box

To Save IFR Overlay Settings:

1. <Click> Options on the menu bar.

2. <Select> the Save IFR/VFR Overlays menu option to display the cascade menu.

3. <Select> the IFR menu option to display the Save IFR Overlays dialog box.

4. <Select> the desired setting option(s) for each tabbed page.

5. <Click> the Close button in the upper right corner to close the Save IFR Overlays dialog box.

4.9.10  XE "Overlay:IFR/VFR" VFR Overlays

The VFR cascade menu option, available from Save IFR/VFR Overlays menu option of the Options menu, displays the Save VFR Overlays dialog box.  The Save VFR Overlays dialog box provides the capability to setup or change graphic overlays.

The dialog box consists of the Geophysical, Boundaries, Sites, Aero (Aeronautical), and Transportation tabbed pages.
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Figure 4‑97  Save VFR Overlays Dialog Box

To Save VFR Overlay Settings:

1. <Click> Options on the menu bar.

2. <Select> the Save IFR/VFR Overlays menu option to display the cascade menu.

3. <Select> the VFR menu option to display the Save VFR Overlays dialog box.

4. <Select> the desired setting option(s) for each tabbed page

5. <Click> the Close button in the upper right corner to close the Save VFR Overlays dialog box.


4.10 Window

The Window Menu is only available when a current product is opened.  It provides the ability to adjust the method in which open windows are displayed.  As more windows are opened and resized, the windows can overlap and eventually obscure or hide another one.  The window commands provide various methods of arranging windows so that they are at least partially visible.  The Window Menu includes the following commands:  Cascade, XE "Cascade" \r "D2HBCascade139"  Tile, XE "Tile"  Arrange Thumbnails, XE "Arrange Thumbnails" \r "D2HBArrange_Thum139"  Close All XE "Close All"  and Numbered Window List.
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Figure 4‑98  Window Menu

To Display the Window Menu:

1. <Click> Window on the menu bar.

4.10.1 Cascade

The Cascade menu option arranges any currently open windows in overlapping style, like offset index cards.  The Cascade option displays open windows from the upper, left corner of the display screen to the lower, right corner of the display screen.  Each window overlays one another with just the title bar and left edge of the window displayed.
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Figure 4‑99  Cascade Option of the Window Menu

To Display the Open Windows in Cascade Arrangement:

1. Open and arrange any combination of two or more current products.

2. <Click> the Window menu.

3. <Select> the Cascade menu option.  The open current product windows are displayed in a cascading arrangement.

NOTE:
The Cascade command is not applicable to Thumbnail windows.  Use the Arrange Thumbnails command to arrange thumbnails in a tile arrangement.

4.10.2  XE "Tile" \r "D2HBTile144" Tile

The Tile menu option arranges any open product windows in a tiled style, with each window displayed in its own space within the display.
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Figure 4‑100  Tile Option of the Window Menu

To Display the Open Windows in Tile Arrangement:

1. Open and arrange any combination of two or more current products.

2. <Click> the Window menu.

3. <Select> the Tile menu option.  The open current product windows are displayed in tile arrangement.

NOTE:
The Tile command is not applicable to Thumbnail windows.  Use the Arrange Thumbnails command to arrange thumbnails in a tile arrangement.

4.10.3 Arrange Thumbnails

The Arrange Thumbnails menu option arranges thumbnails in a tiled style across the application main window.

To Display the Thumbnails in an Arrangement:

1. Open and arrange any combination of two or more products.

2. <Click> the Minimize button on each window that is to be displayed as a thumbnail window.

3. <Click> the Window menu.

4. <Select> the Arrange Thumbnails menu option.  The minimized thumbnail windows are displayed in a tile arrangement.

NOTE:
The Arrange Thumbnails command is not applicable for maximized or adjusted windows.  Use the Cascade XE "Cascade"  or Tile command to arrange these windows.

4.10.4  XE "Close All" Close All

The Close All menu option closes all opened products within the Main Window, both normal and thumbnail views.

To Close All Active Products:

1. <Click> the Window menu.

2. <Select> the Close All menu command.  All active products within the main window are closed.

4.10.5 Numbered Window List

The Numbered Window List is located below the Close All menu option.  All the opened product windows are listed.  This list is often used to bring a hidden window to the front.  Selecting the name of a window brings it to the front.
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Figure 4‑101  Numbered Window List

To Display the Numbered Window List:

1. Open and arrange any combination of two or more products.

2. <Click> the Window menu.

3. <Select> a product from the Numbered Window List.  The selected window is brought to the front of the display and the border is highlighted to show that it is the active window.  Also, the selected list item is indicated by a check mark to the left of the menu item.
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4.11 Help

The Help menu provides Help information for the WIND application.  The Help menu includes the following commands:  Help Topics XE "Help Topics" \r "D2HBHelp_Topics147"  and About Wind.
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Figure 4‑102  Help Toolbar XE "Toolbar"  Button
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Figure 4‑103  Help Menu

To Display the Help Menu:

1. <Click> Help on the menu bar.

4.11.1 Help Topics (Help Menu)

The Help Topics menu provides quick access to each help topic using the Contents, Index and Find options.  Refer to the Help Topics Appendix for detailed information on the help features.

4.11.2  XE "About WIND" About WIND (Help Menu)

The About WIND menu option displays a dialog box containing WIND application development information.

To Display the About Wind Menu:

1. <Click> the Help menu.

2. <Select> the About WIND menu option to display the About WIND dialog box.

THIS PAGE INTENTIONALLY LEFT BLANK
4.12  XE "Download" Download Client

The Download Client process (DownloadClnt XE "DownloadClnt" \r "D2HBDownloadClnt148" ) runs independently from the WIND process.  Its purpose is to connect to a server and download the graphical products.  The Download Client displays the current server IP/NAME, process name to which it is connected, and the last product retrieved.  If the Download Client cannot connect to the server, then the dialog will come to the foreground and display ‘No Connection Established’.  If you close the Download Client process, you will NOT receive weather products.
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Figure 4‑104  DownloadClnt Dialog Box

Table 4‑63  DownloadClnt Dialog Box Description

	Label
	Component
	Purpose

	Connection Status
	Button
	Button displays current connections and allows user to change connection.

	Process on Server
	Text Box
	Shows process name to which the Download Client is connected.

	Reconnect Attempts
	Text Box
	Shows the number of reconnection attempts including manual reconnections.

	Last Successful Connection
	Text Box
	Shows the time and date of the last successful connection established with the designated weather graphics server.

	Primary Thread Download Status Product Class
	Text Box
	Shows last product class displayed downloaded by the primary thread.

	Primary Thread Download Status Product Filename
	Text Box
	Shows last product filename downloaded by the primary thread.

	Secondary Thread Download File Type
	Text Box
	Shows the file type downloaded by the secondary thread.

	Secondary Thread Download Status Filename
	Text Box
	Shows the last filename downloaded by the secondary thread.


To Display the DownloadClnt Dialog Box:

1. <Click> on the DownloadClnt button located on the Windows Task bar at the bottom of the screen.  The DownloadClnt dialog box is displayed.

4.12.1  XE "Server Name and Port Number" Server Name and Port Number

The Server Name and Port Number dialog box can be accessed from the DownloadClnt dialog box.  The Server Name and Port Number dialog box provides the capability to change servers.   The Drop-down list will normally contain two entries, the primary server and the weather backup server.  If the primary server goes down, the software will automatically attempt to connect to the secondary (the weather backup server).  You can use this dialog to connect back to the primary server.
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Figure 4‑105  Server Name and Port Number Dialog Box

Table 4‑64  Server Name and Port Number Dialog Box Description

	Label
	Component
	Purpose

	Server Name
	Drop-down List Box
	Select server to connect to from drop-down list.

	Quick Sync
	Check Box
	Allows the WIND process to view the available products being sent by the weather graphics server almost immediately at startup.

	Port Number 
	Text Box
	Displays server port number, automatically filled in by system.

	OK
	Button
	Accepts and applies any changes and closes the dialog box.

	Cancel
	Button
	Closes the dialog box without accepting any changes.


To Change the Server Connection:

1. <Click> on the DownloadClnt button located on the Windows Task bar at the bottom of the screen.  The DownloadClnt dialog box is displayed.

2. <Click> on the Connection Status button.  The server name and port number dialog box is displayed.

3. <Select> desired server from the drop-down list.

4. <Click> on the OK button.  The server name and port number dialog box closes and the new server name is displayed on the Connection Status button.

5. <Click> on the minimize button to remove the DownloadClnt window from the screen.

THIS PAGE INTENTIONALLY LEFT BLANK
4.13  XE "GPS/RAIM" \r "D2HBGPS_RAIM151" GPS/RAIM

The GPS/RAIM Sched is run independently of the WIND process.  Its purpose is to graphically depict GPS coverage for individual airport sites for up to 54 hours.  Each square represents five minutes of coverage.

4.13.1 GPS/RAIM Sched

To Display the GPS/RAIM Sched

1. <Click> on the Start button located on the Windows Task bar at the bottom of the screen.

2. <Select> GPS-RAIM Sched.
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Figure 4‑106  GpsRaimSched Window

4.13.2 GPS/RAIM Settings

The GPS/RAIM Settings dialog may be accessed through the GpsRaimSched menu bar.  Use this dialog to add and remove sites to display GPS coverage.
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Figure 4‑107  GPS / RAIM Settings Dialog Box

Table 4‑65  GPS / RAIM Settings Dialog Box Description

	Label
	Component
	Purpose

	Add
	Button/Text Box
	Add an airport site to display GPS coverage.

	Remove
	Button/Drop-down List Box
	Remove an airport site that is currently displaying GPS coverage.

	Covered
	Button
	Used to set the color for time periods that are covered by GPS.

	Not Covered
	Button
	Used to set the color for time periods that are not covered by GPS.

	Unknown Coverage
	Button
	Used to set the color for time periods for which GPS coverage is unknown.

	Start Offset
	Spin Box
	Used to change the start time periods of GPS coverage displayed.  The Start Offset is the offset from the current time.

	End Offset
	Spin Box
	Used to change the end time periods of GPS coverage displayed.  The End Offset is the offset from the current time. 


To Display a Site’s GPS Coverage

1. <Click> on the Add text box.

2. Enter the site ID.

3. <Click> on the Add button.

OR

4. From any displayed product with GPS/RAIM overlaid onto the image, press the right mouse button.  A menu appears.

5. <Select> GPS/RAIM from the menu.  A submenu will appear with a select number of sites in the vicinity of the mouse pointer.

6. <Select> the desired site ID.  If the GpsRaimSched process is not running, it will be started automatically and the selected site will be displayed.

To Change the Start/Stop offset time

1. <Click> on the up or down arrows of the spin box.  The display will dynamically update as the time changes.

To Remove a Site’s GPS Coverage

1. <Click> on the down arrow of the Remove drop-List.

2. <Select> the site to remove.

3. <Click> on the Remove button.
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